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Introduction 

Congratulations on purchasing iAddress™. You are now ready to correct the addresses in 
your databases and validate them against Canada Post or USPS' requirements. As well, 
iAddress™ will sort your mailing databases into the proper sequence, print mailing labels 
and generate mailing reports. 

This manual will familiarize you with the utilities and features found in the iAddress™ 
product. You will learn, in detail, the step-by-step processes in iAddress™, from creating 
jobs, to printing labels. 

 

 

Additional Products Available from Flagship Software Ltd. 

Geocoding 

Harness the power of iAddress™ Geocoding to enhance your data and focus on relevant 
offers in a specific geographical area for all your targeted marketing needs! iAddress™ 
Geocoding will convert postal address data into longitude/latitude coordinates, enabling 
a more precise selection of data. Many filtering options are available to tailor your data 

http://www.flagshipsoftware.com/manual/index.php/manual/
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by distance, number of records and non-geocoded addresses.  Available as an add-on 
utility and designed to seamlessly integrate with iAddress™. 

iFuse 

Simplify your small mailings with iFuse!  This module works seamlessly with iAddress™ 
to create a series of merged reports by selecting multiple iAddress™ jobs of similar 
qualities. The result is three combined reports: Validation, Statement of Mailing and 
Mailing Plan which can be uploaded to Canada Post.  Available as an add-on to iAddress™ 
full version. 

AddressMinerPRO 

Is a separate utility designed to help manage disorganized data files. AddressMinerPRO 
can extract address data from files where there is no order or discernible structure, and 
where address data is stored in single fields. Previously, in order to work with a file like 
this, you would have had to manually edit the file to properly order the fields. This can 
be very difficult and tedious with files that contain thousands, or even hundreds of 
thousands of records.  

NCOA 

Keep your Canadian customer files current even if they relocate. Using Canada Post mover 
data, process lists in real-time to ensure you stay in contact. Standard NCOA processing 
includes access to the mover data as well as do-not-mail and enhanced deceased 
suppression at no additional charge. Requires signing the appropriate Terms of Use with 
Canada Post annually. 

NCOALink 

Keep your US customer files current even if they relocate. Using USPS’s NCOALink data, 
process lists in real-time to ensure you stay in contact. Available as an annual, unlimited 
license, NCOALink processing requires annual signing of a USPS Processing 
Acknowledgement Form. 

iEnvelopePRO 

Want to make your mail stand out above the crowd? Your solution is iEnvelopePRO! This 
stand-alone utility provides design tools to create a unique custom-made envelope from 
invoices to advertisements. This easy-to-use, drag-and-drop software accepts most 
database formats including Access, Excel, dBase and text files and allows insertion of 
Fixed, variable and rotated text, along with Graphics, indicias, permits and barcodes. 
iEnvelopePRO is compatible with most production ink jet printers using your installed 
WindowsTM drivers and seamlessly integrates into iAddressTM when installed on the same 
computer. 
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iMark PRO 

iMark PRO is the plug-and-play answer to your inserting needs! This is a simple-to-use, 
Windows PC based drag and drop interface and requires no modifications to existing 
applications. Grouping and sorting documents is easy with iMarkPRO.  There’s no need 
for an expensive, IT-based solution! Let iMarkPRO reduce your printing and postage costs 
and increase productivity by sorting through your unprinted documents and collating the 
pages for the same recipient in one envelope or by emailing the customer. Available as a 
stand-alone product. 

Before Getting Started 

Before you start to use iAddress™, you should ensure that your databases are in good 
order. This means that you should have correct address information and proper Postal 
CodesOM or Zip Codes. 

iAddress™ requires you to have sufficient disk space on your hard drive so that the 
program utilities can run efficiently. The disk space required can be calculated, as follows: 

• Determine the size of the database you will be sorting into the Canada Post LCP. 

• You need 2.5 times the size of the database. 

If you have this amount of disk space on your hard drive, you are ready to use iAddress™. 

Copying Data from a CD 

To ensure iAddress™ is running as efficiently and quickly as is possible for your system, 
it is required that the appropriate data files are copied to your hard drive. iAddress™ has 
an automatic install and update utility that will download the latest files over the internet. 
The downloader can be accessed from the "Tools" menu. 

The following instructions can be followed should you wish to copy data from the CD 
instead of using the automated process. 

Copying Data: 

From the "File" menu click on "Copy US Data" for the US Data, or "Copy Canadian Data" 
then "Download" or "DVD" for the Canadian Data. If you are selecting to copy data from 
the DVD, then please ensure that the DVD with your desired data is in the DVD tray. 
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Entering your Company Information 

In the file menu scroll down to “Company information”. Here you can enter information 
you would like to be visible in reports. 

 

The first tab, "Company Information" requires the following: 

• Your company's name 

• Your complete mailing address 

If you are creating mailings for your customers, enter the customer's name and Canada 
Post number on this screen. 
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Both the company and the customer information screen have a button to enter the 
various ID's used by CPC and USPS.  By clicking this button you will be taken to a new 
screen where you can enter at the very least, your CPC account number and/or your 
USPS mailerID & CRID. 
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The Job Details screen stores the Canada Post database serial number as well as the 
Office of Deposit information.  
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Seed Records 
 
You can create seed records to add to your database. Add the records using the Seed 
Records tab under the Company Information screen. The seed records will be stored as 
a separate database that you can add to your current job using the “Add to Current 
Database” button. Normally seed records are added at the Select Address screen 
(described later in the manual). 
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You can group your seed records by using the Seed Group tab.  This is useful if your 
customers have specific addresses they would like added to their databases only. 
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• Create a group by clicking the Create Group button and giving the group a name. 
Then add records to this group by selecting the appropriate seed records and 
clicking the Add to Group button. 

• To remove addresses from a group, select the record in the Seed Group and click 
Remove from Group. You can rename your group using the Rename Group button 
or remove an entire group by clicking Delete Group. 

Registration 
 
Serial numbers were issued with your software purchase; if you were not issued serial 
numbers or do not have a record of them, please contact Flagship Software technical 
support. Once you have your serial numbers, select Register from the Help menu. 
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The following screen will appear: 
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File 

Viewing your Database 

View Database permits you to view your iAddress™ database in a table-style view. You may edit 
or delete records in this mode. 

 

From the File menu, select “View Database”. The following screen will appear: 
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In this view, you may look at: 

• All addresses 

• Valid addresses only 

• Corrected addresses only 

• Uncorrectable addresses only 

• Duplicates only 

• Common records only 

• All fields within the database 

You can print some or all of your addresses from the View Database screen, if you 
choose. 

Note: 

Valid, corrected and uncorrectable addresses can only be viewed after 
validation/correction has been run on the job. Duplicates and common records can only 
be viewed after duplicate extraction has been performed. Uncoded records can be 
viewed after sortation. 
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Deleting Records 

Records can be deleted in this view. This is useful for selectively deleting duplicates 
after the “Purge Duplicates” operation. To delete records individually, click it, then click 
the “Delete” button above the database. To delete multiple records, hold down the 
“Ctrl” key while selecting records, then press the “Delete” button on the screen. 

You may also select an individual record by clicking on it. You can then manually check 
this record’s address by clicking “Look-up”. 

Exporting the Database 

Choosing the Export Database option allows you to export your data to a database or text file. 

 

Select “Export Database” from the File menu. The following screen will appear: 

You may now select the content and format of the export database. The options are as 
follows: 
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• Valid Addresses: 

All valid addresses from the original database are retained. 

•  Corrected Addresses: 

All addresses corrected by iAddress™ are retained. 

•  Uncorrectable: 

Addresses iAddress™ was unable to correct are retained. 

• Questionable Addresses: 

Addresses that are listed as Questionable by iAddress™ 
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• Export in Original Order: 

Keeps your database fields in the same order as the original file. 

• Extra Control Fields: 

Fields created by iAddress™ during correction/validation and presortation. 

• Add Original Address Fields: 

Permits you to see the original state of your address fields as well as any corrections or 
changes. 

• Include All Other Fields from Original Database: 

Permits you to export additional fields contained in the original database (for example: 
customer numbers, phone numbers, etc.). 

• Include Audit Log: 

Allows you to export the audit log in order to track manual changes made to your 
database. 

• Add Leading Zeros to List order: 

Helps retain numeric formatting for dBase files. 

• Add Correction Fields: 

Permits you to see the corrections that have been suggested or applied to your 
database. 

• Add Status and Comment: 

Allows you to enter information about individual records. 

• Add Address Components: 

Adds fields of your address separated into its components (for example: street number, 
street name, street type, street direction, etc.) 

• Choose Export Fields: 

Allows you to choose specifically which fields you would like to export. 
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Once you have sorted your file, you can also export: 

• Uncoded records 

• Foreign records 

After selecting your options, click Export Database. On the Save As screen, enter a 
location and filename for the new database. Click Save. 

Preferences 

There are default settings in iAddress™ that relate to program preferences, marking of 
bundles and autosave features. To change the defaults, select “Preferences” from the 
File menu. 
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Settings 

The settings tab allows you to choose your default preferences related to the iAddress™ 
program. 

 

Language 

Use this button to switch between English and French displays in iAddress™. Please note 
that not all USPS terms have French equivalents and will be displayed in English. 

Enable Audit Trailing 

This feature will track manual changes you have made to your database. For example, 
the Audit Log will show record deletions, additions, and any changes you made through 
the Address Lookup screen. 
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NCOA (SSL) Secure Transfer 

Enable the NCOA (SSL) Secure Transfer to have your information encrypted when using 
the NCOA/CMA feature. 

Check for Updates on Startup 

If you have an Internet connection on this computer and would like iAddress™ to 
automatically check the update server for any program updates, leave this option set to 
“ON”. 

AutoSave 

Your job file is automatically saved after each step in the correction/validation and 
sortation process. Should you unintentionally exit iAddress™ without saving, you can 
recover your job by clicking the “Go to AutoSaves” button. AutoSaves are named by the 
date and time of their creation. 

To prevent auto saves, turn this option to “OFF”. 

Important! 

You should periodically delete your old auto saved files to conserve hard drive space. 
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Data Paths 

The Data Paths tab allows you to choose your default paths related to the iAddress™ program. 

 

Default Paths 

You may set the default folder that iAddressTM uses when it: 

• Import files to create jobs 

• Exports and saves 

• Export for Printing 

You may either set these manually to a preferred folder, or check the 'Remember Last 
Path' checkbox to allow iAddress™ to default to the last path used. 

Postal Data Location 

Lists the paths where iAddressTM stores its data files. 
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DBF Code Page 

You can set the default handling of dBase files.  Older versions of dBase use OEM 
codepage to store accented characters, while newer versions use ANSI codepage to store 
accented characters.  An incorrect setting may result in accented characters being 
improperly displayed. 

CA Sort Preferences 

The CA Sort tab allows you to choose your default preferences related to the Canadian Sort. 

 

 Bundle Breaks 

• During the sortation process, you may choose to indicate the first, last, or first and 
last piece of each bundle, container, or pallet. The default characters provided 
indicate the breaks; if you would prefer to change them simply enter a new 
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character for each type of container. If you do not wish to have the breaks 
indicated uncheck the “Bag/Bun column add bundle break” checkbox. 

OEL 

• The Optional Endorsement Line replaces the bundle labels by printing this 
information directly on the address labels on the first line above the address. 

 

Important! 

• The OEL is created automatically during the sort but it is an optional feature. You 
must manually select the OEL field in Windows Print or DOS Print in order for it to 
be printed on the address labels. If you export your addresses for printing, you 
must position the OEL field on your labels. If you prefer not to use the OEL, bundle 
labels can still be used. 

 

Pallet/Monotainer Defaults: 

• If you use pallets or monotainers for your sorted jobs, you can enter your preferred 
quantities and dimensions here. This will replace the Canada Post maximum and 
minimum amounts with your selected quantities and dimensions. 

US Sort Preferences  

The US Sort tab allows you to choose your default preferences related to the US Sort. 
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 Number of Stars in front of the Optional Endorsement Line 

You can set the number of stars in front of the optional endorsement line. 

 Include **AUTO at the beginning of automation OEL lines. 

This option lets you choose whether to include **AUTO at the beginning of automation 
OEL lines. 

 Use Code 128 Barcodes for Tray Labels 
 

There are 2 available barcodes for tray labels, by default it is an interleaved 2 by 5 barcode 
but if the 128C tray labels and GS1-128 Pallet labels are preferred this option can be 
selected. 
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Container / Bundle Markings 
 

Break String On: 
 

• Choose to place the marks on the first, last or first & last of the piece within the 
grouping to which it belongs.   
 

Bundle/Container/Pallet Markings 

• The markings to be used, traditionally * for bundles, * for containers 
(trays/sacks) and P for pallets.  On a pallet, tray and bundle change the mark 
would appear P**. 
 

 Optional Endorsement Line on Bundle Sorts 

You can choose one of the following preferences for the optional endorsement line on 
bundle sorts: 

• Place on the first piece of every bundle 
 

• Place on the last piece of every bundle 

• Place on the first and last piece of every bundle 

• Place on every piece in the bundle 

Extended Export 

As you may have recently noticed, there’s a new export option available for Canadian 

jobs in iAddress called Extended Export 
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This new export screen is designed to give you full control over the export of your 

data from iAddress in a clear and intuitive fashion. 

 

As seen above, there are 4 main sections on the Extended Export screen: Record 

Types, Fields, Order and Export Options. 

Record Types 
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The record types section allows you to select exactly what type of records you want 

to include in the exported file. These options are completely inclusive, if it is checked, 

that type of record will be exported and if it is unchecked it will not be. For example, 

if you wanted to export only the valid and corrected addresses, you would leave 

checked Valid Addresses and Corrected Addresses and leave unchecked Uncorrectable 

Addresses and Foreign Addresses. Questionable is a status modifier on (A valid or 

corrected address may be questionable – this applies to rural addresses where the 

less strict SERP Rural rules apply). 

Options that are unavailable will be greyed out and unable to be selected. These are 

options which don’t apply because the requisite process hasn’t been run – for 

example, correction status will be disabled if correction hasn’t been run on the job. 

Above, everything but Deceased list processing has been done, thus everything is 

available except for Deceased Records. 

 

Fields 

 

 

The fields section allows you to select which fields (or columns if you prefer) to include 

in the export and in which order they will be listed. The 2 arrows in the center allow 

you to assign columns from the available fields on the left to the exported field list on 
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the right. Selecting a field or multiple fields and using the arrow buttons underneath 

the exported field list allows you to reorder the fields.  

Underneath the two lists are convenience buttons to allow you to quickly assign 

relevant fields. For example, you can add all the other fields that were in the input file 

by clicking All Other Original Fields and you can add all the original address fields by 

clicking Original Address Fields. 

Order 

 

 

The order section allows you to set which order the exported file will be in. 
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Export Options 

 

 

The export options section primarily is where you will select the type of file to export 

to and the name/location to export it to.  For some file formats there will be additional 

options here as well. 

Support 

 

If you encounter any problems or have any questions please do not hesitate to contact 

our support department by sending an email to support@flagshipsoftware.com or 

calling us at 1-866-672-0007 Extension 3. 

Merging Databases into a Single Job 

iAddress™ has a feature that allows you to combine two or more databases into a 
single mailing job. To merge databases, you must open the first database using the 
Create Job or Create ODBC Job command from the main menu and select the 
appropriate fields. When this has been completed for the first database, you can start 
adding files.  Merged files do not need to be the same file type (eg. Access or Excel) 
nor do they need to have the same layout. From the File menu, select “Merge into 
Job”. You must set up every name field for a merge job since the field names in your 
input files may be different. Video. 

mailto:support@flagshipsoftware.com
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The Merge Databases function must be performed prior to Validation. 

• Once you have selected Merge Databases, the Open window will appear. Select 
the database you wish to merge and click “Open”. Follow the same steps as 
outlined for Create Job/Create ODBC Job for selecting the table and assigning 
fields. Once this is complete, you can add additional files or proceed with 
correction/validation and/or sortation. 

Merging Additional Files 

• To add additional databases, simply select Merge Databases again from the main 
menu and follow the above steps. 

•  iAddress™  numbers the imported files 1, 2, 3, etc. If you wish to retain this 
field (MergeFile) on export, you must select Extra Control Fields on the Export  

• Database screen. 

Opening a Saved Job 

 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/p115/screen_shot_07-13-17_at_11.07_am.png?mtime=1502986130
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Select “Open Job” from the File menu. When the file list appears, select the 
appropriate. pjf file and click “OK”. 

 

 

Job Wizard 

The Job Wizard steps you through the process of creating a job.  To use the Job Wizard, 
select “Job Wizard” from the File menu, and then select either "Job Wizard Canada" or 
"Job Wizard United States". 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/p115/screen_shot_07-13-17_at_11.17_am.png?mtime=1502986133
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The Job Wizard steps you through the process of creating a job.  To use the Job Wizard, 
select “Job Wizard” from the File menu, and then select either "Job Wizard Canada" or 
"Job Wizard United States". 

The following screen appears: 

 

Follow the on-screen instructions to progress through the Wizard.  Once the Wizard 
reaches the final step, press the Finish button to run the job. 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/ProcessingYourMail/JobWizard2.png?mtime=1456858346
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Here are step by step screenshots to help guide you through the wizard. 
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• select this option to use the first row as column headers. 

AddressMinerPRO 

AddressMinerPRO is a utility designed to help manage disorganized data 
files.  AddressMinerPRO can extract address data from files where there is no order or 
discernible structure, and where address data is stored in single fields.  Previously, in 
order to work with a file like this, you would have had to manually edit the file to properly 
order the fields.  This can be very difficult and tedious with files that contain thousands, 
or even hundreds of thousands of records. 

Using AddressMinerPRO is quite simple; it integrates directly into iAddress™ and guides 
you through the process of importing your data into iAddress™.  A few quick clicks and 
AddressMinerPRO will import your data directly into iAddress™. 

Starting AddressMinerPRO 

• To get started with AddressMinerPRO, simply click on “Create Address Miner Job” 
in the “File” menu.  This launches the AddressMinerPRO wizard, which will guide 
you through the process of importing your data file.  

Selecting Your File 

• After you have clicked on the menu item, iAddress™ will prompt you for a data 
file.  This is a standard file prompt, so just select your input file and click 
“OK”.  After this, you will be greeted with the AddressMinerPRO start screen, 
where you can select where you want the “rejects” (records which 
AddressMinerPRO could not parse) to be exported.  The default is 
<filename>.rej.<fileextension> in the same folder as your input file.  This screen 
will also give an option for label files.  (This will be covered later in this document.) 
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Selecting Text Format (Text files only) 

• This screen is similar to the screen you would see in iAddress™ to select the format 
of your text file.  Like the screen in iAddress™, it will usually select the correct 
format automatically.  However, unlike in iAddress™, you do not specify whether 
it has a header row on this screen - that comes on the next screen. 

  

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/ProcessingYourMail/AddressMinerPro2.png?mtime=1456860652
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Data Preview 

• The data preview screen offers a brief preview of your data (it will not show all of 
the records in your file, only the first 50 or so). On this screen, you can select 
whether or not there is a header row and it will update the preview, changing the 
column names. You can also optionally specify fields for AddressMinerPRO to 
ignore.  For example, in the image below, we know that the first 2 fields are name 
fields only and that no address data exists in these fields.  Therefore, we tell 
AddressMinerPRO to ignore them in processing, although they will still be imported 
as separate columns.  We also have a few fields after all the addressing 
information that includes identifiers and miscellaneous information that is not 
address related. 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/ProcessingYourMail/AddressMinerPro3.png?mtime=1456860664


FLAGSHIP SOFTWARE LTD. MANUAL VERSION 4.0| 49  
 

 

 

Complete 

• After you click ok on the File Preview screen, AddressMinerPRO will process the 
file and import it into iAddress™.  Any records that were unable to be parsed will 
be exported to the separate file specified earlier, however, the original structure 
of the input file is maintained in this export file.  From this point, iAddress™ will 
function exactly the same as if you had created a job normally and mapped your 
fields.  If you need to map name fields, you will need to export this data and create 
a job using that export file.  

Label Formatted Files 

• On the start screen if you check off “Label File”, AddressMinerPRO will then convert 
a label formatted text file into a proper data format and import it into iAddress™. 

 

  

 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/ProcessingYourMail/AddressMinerPro4.png?mtime=1456860678
http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/ProcessingYourMail/AddressMinerPro5.png?mtime=1456860691
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Select Type of Label Format 

• On the next screen you simply specify in what format your label formatted text file 
is.  If the labels are separated by blank lines, then you would select “Line Feed”.  If 
they are separated by a form feed, then you select “Form Feed”.  If your labels 
are fixed line (for example, every label is 5 lines long) you would select “Fixed 
Line” and specify the number of lines.  When you click continue, AddressMinerPRO 
will process your file and import the results into iAddress™.  NOTE:  There is no 
preview screen since AddressMinerPRO will automatically detect the data after 
converting the label to a readable record. 

  

 

Creating an ODBC Job 

• Creating an ODBC Job allows you to use the ODBC connection. Select “Create 
ODBC Job” from the file menu. You will be prompted for your ODBC (Open 
Database Connection) connection. After you have selected your ODBC connection, 
the steps are the same as for “Create Job”. 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/ProcessingYourMail/AddressMinerPro6.png?mtime=1456860706
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Saving a Job 

Save Job saves the current state of your database and reports after 
validation/correction or presort has been performed. “Save Job” can be performed at 
any point in the correction/validation or presortation process.  
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The window below opens and specifies that the file will be in the directory you were in 
the last time you saved a job. Select the directory you wish your job to be saved in. 

 



FLAGSHIP SOFTWARE LTD. MANUAL VERSION 4.0| 53  
 

After selecting the appropriate directory, type a descriptive name for your job and click 
“Save”. 

Creating a Job 

To start a new job, select “Create Job” from the File menu. 

 

Select the database and click “Open” or double click the database. Once your database 
has opened, a screen will appear to continue with the next steps. 

Multiple Tables in a Database 

If multiple tables exist in the database, a window will appear listing the tables and the 
number of records in each table. Select the table you want to use, then double click or 
click “Done”. 

If you need to import multiple tables from the same spreadsheet, you will have to repeat 
this process using the Merge into Job feature for each table. 

Text Files 

If you have selected a text database, the following window will appear: 
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Choose the type of text file, select whether your first row is a header row and if you 
would like to load all columns as text columns (recommended) and click continue.  If you 
have chosen a fixed length file, a screen will appear showing you which fields iAddress™ 
has autodetected. You can make changes to your file, and load or save templates. When 
you are satisfied with your changes, click “Create Job”. 

 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/ProcessingYourMail/TextFiles1.png?mtime=1456858980
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Selecting Address Fields 

iAddress™ will automatically attempt to match the database fields to the appropriate 
iAddress™ fields. You can override these entries and select fields iAddress™ was unable 
to locate, as follows: 

From the drop, down list under each iAddress™ field, scroll and select the database field 
that corresponds to the information required by the program. 

 

For example: 

1) Click the down arrow below the Last Name field to bring up the drop down list 

2) Select the field that contains the Last Name information  

3) You can assign a name to your job. If you do not assign a name, a default 
description for your job will be used. 

4) Ensure you have filled in all required fields and any of the optional fields, then 
click “OK”.  

Single Field Data 

Canada: 

• City, Province and Postal CodeOM, you must check the “One Field: City Province 
Postal / ZIP” box 

• City and Province, you must check the “One Field: CityProvince” box  
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 US 

• City, State, and Zip CodeTM, you must check the "One Field: City State 
Zip(Zip+4)" box 

• City and State, you must check the "One Field: City State" box 

 You will then be prompted for the field name containing this information 

Multiple Field Components 

• If your address is split into many field components (eg. apartment, street number, 
street name, etc.), click the button to the right of the first address line. Select all 
address line components in the order you want them to appear and click Done. 

 

Language Indicator (Canada) 

• If your database has a field that indicates whether the entry is French or English 
and you wish to use this information in your correction, select the appropriate field 
from the drop-down menu. Beside each language, enter the appropriate code. 

To view your data 

• If you are unsure of the data contained in the fields, use the horizontal scroll bar 
below the database box to scroll left and right. This scroll bar will also allow you 
to see what will appear in the iAddress™ fields. Fill in any field, then scroll left and 
right.  

 

 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/ProcessingYourMail/SelectingAddress2.png?mtime=1456859317
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Using Templates 

• If you frequently create jobs using the same data file, you can create a template. 
This template stores the field information so you do not have to select your fields 
when creating a new job. 

Character Set 

• This option tells iAddress™ what type of system the data originated from so that 
it can “translate” various computer codes. The default is Windows; some users 
require OEM if their data did not originate from a Windows-based system. 

Using Customer Information 

• If you have entered information on your customers under Company Information, 
you can use the drop-down here to select them. This will display their name and 
their associated USPS or Canada Post account number on reports. 

Remove Header Row 

• If you are using an Excel File and the first row contains the column headers, 
select this option to use the first row as column headers.  

Address Management  

Duplicate Extraction 

Video 

Duplicate extraction utility allows you to identify and selectively remove duplicate 
records from your database. If you merge 2 or more files, you can identify records that 
are common between them.  This is useful for removing suppression lists, also known 
as Kill Files. 
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From the Address Management menu, select “Priority Duplicate Extraction”. Click 
"Process" to preform the extraction.  
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By default, iAddress™ checks for duplicate records based on address. You can 
customize your duplication by choosing some, all or no parts of the address. “City” is 
not selected by default to take into account alternate city names (for example Elk Falls, 
BC/Campbell River, BC or North York, ON/Downsview, ON). 

 You can also include other fields to identify duplicates. These are as follows: 

• First Name 

All records with the same First Name will be identified.  First Name will only be available 
if you have bound the first name field when creating your job. 

• Last Name 

Records with the same Last Name will be identified.  Last Name will only be available if 
you have bound the Last Name field when creating your job. 

• Name Line (1, 2, 3) 
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Records containing the same information in the appropriate name line will be marked as 
duplicates. 

• Partial Names 

Records are identified if the names are similar. For example, Commercial Bank, 
Commercial Bank of Canada and Commercial would be considered duplicates as long as 
the addresses were the same. 

• Ignore Rural Addresses 

By selecting this option, iAddress™ will not check rural addresses for duplicates. 

• Blank and non-blank lines are not duplicate 

If no data is contained in a field, iAddress™ will consider this to be a unique entry and 
will not match it to non-blank entries. 

• Records with all blank names are not part of duplicate processing 

Any records where all the name fields are blank are left out of the process while 
checking for duplicates. 
  

Percent match 

The percent value entered in this box allows the user to determine how similar two 
name fields must be before they are identified as duplicates. The higher the percent, 
the more exactly two name fields must match. To find exact matches, the percent 
should be set at 100. Lowering the percent value will allow for spelling mistakes. 

 Processing duplicates 

To check your database for duplicates, select the “Process” button and the progress bar 
will be displayed above the buttons.  All records identified as duplicates are flagged; 
common records are those identified in your suppression list (Kill File) that appear in 
any other databases merged into your job. 

 When processing is complete, you can choose to view your duplicates or  common 
records or delete them. 

 Duplicate report 

Click Print Report to produce a detailed description of your duplicate extraction results. 
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 To view duplicates 

Selecting the View/Print  will open the View Database screen with the Duplicates 
selected. From this screen, you can print a list of duplicate addresses or selectively 
delete them.   You may also flag or de-flag records as a duplicate. 

 

 

   

Deleting duplicates 

Duplicates may be automatically removed using Delete Duplicate Addresses. The 
following warning will appear with the total number of records to be deleted: 
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Note: 

iAddress™ will automatically retain the first occurrence of the addresses and delete all 
additional duplicates found. 
Information about duplicates can be exported using the Extra Control Fields option on 
the Export Database screen. 

 

  

To run your job 

After selecting all your options, click “Process”. 
To stop this process while it is running, click “Cancel”. 

Using a kill file 

Kill/Do Not Mail files (suppression lists) are used to remove addresses from the main 
database(s). If you have merged more than 2 files, you will need to identify the kill file. 
Click the “Select Kill File” button and choose the appropriate file.  After processing, all 
records matching the Kill file will be marked as common.  You can view, print and/or 
export these records.  When you are ready to remove the Kill file and all matching 
records, click subtract. 

Setting priorities for duplicates 

You can decide which of your duplicate identification criteria is more important by 
setting priorities. 

 Deduping before correction 
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If you process your duplicates before correcting your file, you should choose the 
Perform Precorrection option. This option corrects and standardizes your records to 
produce the best results. 

 Once your Criteria and Options are selected, click Set Priority. The following screen will 
appear. You can determine which options are most important by moving them up and 
down the list. If you don’t want to use a particular option, you can remove them. You 
can move items related to each option in the right hand box. You can also delete them, 
if they are not important to your duplicate extraction. 

  

 Length 

This option selects the duplicate with the most number of characters. For example, if 
this option were selected for the First Name field, JONATHON would be considered a 
higher priority duplicate than J or JOHN. When you delete your duplicates, JONATHON 
would be retained while J and JOHN would be deleted. 

File order 

If you have merged two or more files, you can determine which file is more important 
when determining duplicates. For example, if the third file you merge into your job is 
your main customer list, you can select this as the priority. If duplicates are found in 
your file, duplicates found in your main customer list will be considered a higher 
priority. When you delete your duplicates, the record from this file would be retained 
while the others will be deleted. 

Language 
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This option will prioritize duplicates by language. If English has been selected as the 
priority, French duplicates will be deleted before English ones. 

Correct or valid 

Part of the standard normalization process involves a correction/validation. You can use 
this information to set priorities with your duplicates. By selecting this option, when 
duplicates are found, valid addresses will receive a higher priority. When you delete 
your duplicates, a valid record would be retained while others will be deleted. 

Random 

If two or more entries are exact matches, this option randomly selects one over the 
others. This option is always the “last resort”, that is, if other priorities have been 
selected and there are still duplicates remaining, the random selection will happen.  

 

Note: 

The drop-down list beside the Set Priorities shows the priorities you have selected and 
the order in which they will be applied to your job. 

 

 Superior record creation 

This option allows you to create one record using parts of two or more duplicate 
records. Once you have processed your duplicates, you can access this feature by 
clicking the “View/Print” button and selecting “Merge” from the View Database screen. 
You can then select components from each duplicate record to create a single entry in 
your database. 

Adding Salutations 

Genderization uses the first name information from your database to determine if the recipient is 
male or female. This allows you to address the mail using salutations such as Mr. and Mrs. This 
option will not be available if you have not selected a first and last name field. To perform 
Genderization, select Genderization from the Address Management menu. 
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 This screen will appear (screen will vary slightly, depending if your job is U.S or Canadian): 
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Select the column that contains the first name information using the Column to Genderize 
drop down list.  Enter the salutation in the prefixes boxes. For Canadian mailings, you 
may add one for English, and one for French. Defaults can be changed to suit your mailing 
requirements. You can override the gender assigned to a name by iAddress™ by adding 
the name and associated gender in the Tools/User Gender options screen.  Canadian 
mailings are also required to select whether the file is all English or all French; if you 
chose a language indicator column in the database when you created the job, you may 
also choose "Language Indicator" to determine language. 

Field Formatting 

Selecting Upper/Lower Case from the Correction Options screen will case your address 
fields only. To format the rest of the fields to be printed, select Field Formatting from 
the Address Management menu. 

 

Once you have selected Field Formatting, the following screen will appear: 
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On the left is a list of the fields available for Upper/Lower casing. Click on the fields you 
wish to Upper/Lower case. To deselect a field after selecting it, click on it again. 

Once you are satisfied with your field selection, choose the format you prefer for these 
fields from the following: 

•  All Upper Case will format the fields as UPPER CASE (eg. MACGRADY, SMITH). 
• All Lower Case will format the fields as all lower case (eg. macgrady, smith) 

• Capitalize First will capitalize only the first letter of each word in your field. 
(eg. Macgrady, Smith) 
 

• Rule Capitalization 

o Business Rules: Will find two or one letter words and set them full capitals 
and the rest are Person Rules. 
 

o Person Rules: Checks your fields for words that commonly have two 
capitals in them (eg. MacGrady, Smith) 
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• Apply Address casing rules to Address Fields will use specific casing rules 
for street types and the like. 
 

Acronyms 

If you wish to expand acronyms (eg YMCA, IBM) or shorten names to acronyms, select 
the appropriate option on this screen. iAddress™ has a database of common 
acronyms.  You can add your own or change the casing through the Tools/User 
Acronyms option 

 After making your choice, click OK 

Address Look-up 

Address Look-Up is a utility to find and/or verify addresses. You may do a lookup on a 
US or Canadian address by selecting the appropriate lookup menu option. 

Note: 

You do not need to have a job loaded to use the lookup screen.  

 

After selecting US or Canadian Address Look-Up from the Address Management menu, 
one of the following screens will appear: 
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Type in as much information as you have in the Quick Search fields. Click Correct 
Address. If you have provided sufficient information, the address will be corrected. 
You can also use the buttons “Search Street Name” (Canada Only) or “Search Postal/Zip” 
to display a range of addresses above the Quick Search fields. 
To add a new record to your database, click the radio button labeled Add Record. Once 
you have entered information into the address and name fields (if displayed), click 
Address Save. 

 Using the Drill Down Feature 

You can locate addresses by using a drill down feature included in the Search section of 
the Lookup screen. Use the drop-down to select the appropriate province or state. All 
cities in that province or state will then be listed. You can scroll through the list or type 
in the “City” field. Once you have entered the city, click “Select”. 

 You can now find the address by street type, as well as additional information about 
the address. 

 To find the address by street name, click the “Streets” tab. Select the appropriate 
street name, and click “Lookup”. The ranges will be displayed above the tab. 

 

 

•  You can display or search for General Delivery addresses, PO Boxes or Rural 
Routes on the “GD/RR/PO Boxes” tab 

• Alternative names for city streets are listed under the “Alternate Streets” tab 

• (Canada Only) Large volume receivers and their Postal CodesOM are displayed 
on the “LVRs” tab 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/AddressManagement/Lookup3.png?mtime=1456937913
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• (Canada Only) Alternative city names are displayed on the “Alternate Cities” 
tab. Some alternative names are not recognized by Canada Post but may be 
used locally 

Look-Up from View Database 

If you selected an address from the View Database screen, using the Look-Up button, 
your address will be entered automatically under quick search. You can then use the 
options described above to correct your address. 

The auto-search option will automatically find the address entered in the Search screen. 
This can facilitate searching for addresses by avoiding reentry of data. Uncheck this box 
if you don’t want the auto-search feature enabled. 

 

Important! 

If you have looked up an address from the View Database screen, the “Address Save” 
button will appear. If you correct your address and click this button, the database and 
the Validation Report will automatically be updated.  

Filter Mailing 

You may wish to mail only parts of your job, perhaps as a random sampling or to addresses 
meeting specific requirements. By selecting Filter Mailing from the Address Management menu, 
you can decide how many addresses and which addresses you want to use for your mailing. 
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After selecting Filter Mailing, you have several options to choose from. You may choose 
one of the following tab options: 

•  Intelligent Selection: Allows you to select your mailing by removing 
States/Provinces, Cities, Address Types and/or FSAOMs (Canada)/Zip 
CodeTM (US). 
 

• Random Selection: Allows you to choose a sample mailing from within your 
database. 

• SQL Exclude: An expert filter, which allows you to craft a database query to 
remove records from your database. 

• Address Filter: A combination filter allowing exclusion based on correction 
types, files or blank lines. 

• Extra Characters: Removes symbols and other characters that represent 
commands in certain database formats. These symbols and characters can 
impact printing of files later. 

• Custom Exclude: An advanced custom filter that allows you to filter based on 
specific rules. 

• Geocode Filter (Canada Only): If you have run Geocoding with a distance 
list, you may filter out records based on distance.   
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 Excluding Addresses 

 

Using the Intelligent Selection Tab, you can delete addresses from your job based on 
the following criteria: 

• Province/State 

• City 

• Address Type (eg. apartments, residences, etc.) 

• (Canadian Mailing) FSAOM (first three characters of the Postal CodeOM), the 
first four or five characters  of the Postal CodeOM, or the entire Postal CodeOM. 

• (US Mailing) Three or five digits of the Zip CodeTM. 

 Scroll through the lists to view the options within each criteria. The number of records 
that match that filter option are listed after each item. In order to exclude more than 
one item  from each criterion, select the first one and click the Exclude button. Select 
the second item and click the Exclude button. When you are satisfied with your choices, 
click “Done”. 

 Selecting a Sample Mailing 

To prepare a random sample from your database, click on the “Random Selection” tab. 
The following screen will appear.   

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/AddressManagement/Filter2.png?mtime=1459443585
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• Enter the number of records. After pressing “Select”, the total number of records 
in the database is changed to the number you selected. You may still exclude 
addresses from this sample using the Intelligent Selection and Exclude Tool 
options. 

• If you select the "Filter Only Uncorrectables" option then the records that are 
discarded will come only from the uncorrectable records.  If you do not have 
enough uncorrectable records then nothing will be filtered and you will be 
informed. 

Custom Exclude Tool 

• Using the Custom Exclude Tool allows you to remove addresses based on very 
specific criteria from any field within your database. Click on the tab labeled 
“Custom Exclude Tool”.  Select the field you wish to use from the Filter Where 
drop down. 

• The center drop down menu contains the selection operators. Empty fields can 
be detected using " is null " or non-empty fields with " is not null ". Comparing 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/AddressManagement/Filter3.png?mtime=1459444213
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alphanumeric fields can be done using the " like " operator with wildcard 
characters. For example " *main st " would select anything that ended in " main 
st ". For numeric fields, these include such operands as +, -, =, >, <. 

 

 SQL Exclude 

• The SQL Exclude tool is an advanced form of Custom Exclude tool allowing you 
to create your own SQL ' where ' clauses. 

• The fields on the left are listed as a reference but can also be inserted in the 
WHERE clause text box by double clicking the field name. 

• To generate the WHERE clause simply type the entire statement in the WHERE 
clause text box.  The WHERE clause text box does not require the word ‘Where‘ 
simply begin from the first statement, for example CITY= 'Buffalo' AND STATE= 
'New York' to select all records that match to the city of Buffalo and the state of 
New York.  
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Address Filter 

 
Address Filter tab has three specific functions.  

 
  
  

Select Records 
 

The first allows you to remove records based on their correction status.  Please note, 
that you must run a Correction/Validation before these options become available. These 
status types are: 

• Uncorrectable 

• Questionable 

• Corrected 

• Valid 

• Foreign 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/AddressManagement/Filter5.png?mtime=1459445678
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• Uncoded 

Select the type(s) of addresses you want to remove by checking the 
appropriate boxes.  Click Exclude. 

•  Select files: may specify which records you want removed by the originating 
source file.  To do this, select the record type  and then files(s) from which you 
want the records removed. 

•  Blank lines: to remove addresses which do not contain data in certain fields, 
select the “Blank Lines” tab.  Click the field you wish this condition to apply to 
and select “Exclude”  

Extra Characters 

• If your database contains symbols or characters within the data, you can remove 
them automatically by using the Extra Characters screen. Select the characters 
you wish to have removed, or leave the defaults if you are not certain. After 
selecting “Replace”, iAddress™ will tell you how many extra characters were 
found and replaced within your file. 

•  
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 Geocode Filter (Canada Only) 

• After you have run Geocoding on your file, you can use the filtering tool for 
targeted mailings.  On this tab you can remove records from your database 
based on Geocoding results. 

•  You may filter out all records that are closer, or further then a specified distance 
with the Filter by Distance text boxes.  You can also Filter by Pieces, which will 
remove the specified number or farthest or closest records.  Checking the "FIlter 
Non-Geocoded Addresses" option will remove any records that were not 
geocoded.   

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/AddressManagement/Filter6.png?mtime=1459446174
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 Important! 

Filtering records permanently changes your job.  If you wish to keep your 
original job, ensure you have saved your job before filtering. Save your filtered job 
with a different name. 

After Filtering 

After filtering your records, you can choose to View, Restore, Clear, Export, or Save 
those filtered records. 

 View 

Clicking "View" will show the filtered records in a database view. 

 Restore 

Clicking on the "Restore" button will remove all your filters, and restore all the filtered 
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records to the job.  This only works if you have not cleared the filtered records using 
the "Clear" button. 

 Clear 

Clicking on the "Clear" button will permanently remove all the filtered records from the 
job. 

Exporting Records 

If you wish to export your filtered records to a separate database, select the "Export 
Filtered" button and choose a name for your new file. 

Saving Records 

If you wish to have your filtered records split to a seperate iAddress job, select "Save 
Filtered" button and choose a name for your new job. 

Restoring Records 

To restore filtered records, click the Restore Filtered Records button.  Records that have 
been removed using Clear button cannot be restored. 

Split Database 

The split database utility allows you to separate databases with records from more than one 
country and export only those records from the job.  After performing a correction/validation on 
a file, select “Split Database” from the Address management menu. 
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The following screen will appear. 

 

Select which records are to be saved and your export options then click “Export”. 

Demographic Information on your Job 

Selecting the Demographic Analysis option on the Address Management menu displays 
information on your job by province, address type, FSAOM and city. After running 
correction/validation on your job and selecting Demographic Analysis, the following 
screen will appear: 
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You may select which items you wish to see in your report by using the “Add to Report” 
and “Remove from Report” buttons. Select the “Generate Report” button to see the 
results 

 

To view your report, use the scroll bar on the right side of the Demographic Analysis 
screen. Click generate report and something resembling this will appear: 
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Validation Report/Statement of Accuracy 

The Validation Report provides information on the accuracy of your data. It lists the 
total number of records as well as the number of records that are valid, corrected and 
uncorrectable (unable to be corrected).  
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 After correcting your addresses, choose “Validation Report” from the Address 
Management menu. The following screen will appear: 
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Mailing Accuracy 

It is important to check the Validation Report for your accuracy level. If your mailing will 
be less than 5,000 pieces, you do not need to achieve a 95 percent accuracy rate. 
However, if your mailing is more than 5,000 pieces, you must achieve at least 95 
percent accuracy. 

 The percent valid is calculated automatically. From this screen, you can choose the 
following: 

• view corrected addresses 

• view uncorrectable addresses 

• filter corrections 

• print the validation report 

• save to file 
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View Corrected Addresses 

Selecting this option allows you to view and print the corrected addresses. This provides 
a list to bring up to date the original database. The report will show where the 
corrections were made, as well as the accurate address. 

View Uncorrectable Addresses 

Selecting this option allows you to view and print the uncorrectable addresses. This 
provides a list to bring up to date the original database. You may wish to keep some 
addresses in your job considered uncorrectable by Canada Post, such as international 
addresses, and you can delete addresses for which there was insufficient information to 
perform the correction. To remove all uncorrectable addresses, click the “Filter Records 
by Correction Type”. 

 To look at individual uncorrectable addresses, click the “Lookup” button on the “View 
Database” screen. Further information on the Lookup screen is provided in a later 
section.  If you correct theses addresses in the Lookup window and save the results, 
your Validation Report will be automatically  updated.  Instructions on manually 
correcting your addresses are shown below. 

Filter Record                 

You can choose the record by correction type.  For further information see page 49 of 
the manual "Selecting Records” section 

Important! 

If you choose, you can remove all or some of the uncorrectable addresses within your 
iAddress™ job. iAddress™ will automatically bring up to date your validation report.  
 

Print Validation Report 

Validation Reports must be submitted to Canada Post when you are mailing more than 
5,000 pieces. However, you may choose to print the Validation Report for your own 
records, even if your mailing is less than the 5,000 piece threshold. 

 Corrected Report 

This report contains a summary of corrections made to your addresses during 
processing. 
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 Uncorrectable Report 

This report summarizes addresses that couldn’t be corrected and the possible problems 
encountered. 

Making Manual Corrections 

To manually fix your uncorrectable records, first view them in the View Database 
screen. You can enter this screen by clicking View Uncorrectable Addresses on the 
Validation Report screen or by selecting File/View Database and clicking the 
Uncorrectable radio button at the top. 

 Choose the record you wish to manually correct (or the first record in your list) and 
click the Lookup button at the top of the screen. The record will now be loaded into the 
Lookup screen. The feature located to the right of the Correct box will take you to 
Google Maps and will plot the address for you. 

 

 

To see the directory listing for this address you can click either the "Search Postal/Zip" 
or "Search Street Name" buttons. The directory listing(s) for the Postal CodeOM or street 
name will appear in the window. If one of these listings is an appropriate correction for 
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your record, you can double-click the directory entry. A box will appear asking for the 
street number and Apt/PO Box number. Enter the street number and apartment or PO 
box number (if applicable) and click OK. 

  

You can also use the search feature at the bottom of the screen. Choose the 
appropriate province then choose the city from the list provided. Click the selection 
button. A list of all street names will appear on the right. You can search for PO Boxes, 
Rural Routes, Large Volume Receivers (LVR) and verify alternate city and street names. 

  

Saving Your Manual Corrections 

Once you have manually corrected your address, click the Correct button. Your address 
may now be Valid, Corrected or might remain Uncorrectable. If you want to save this 
address back to your job, click Address Save. If you want to keep the original entry, you 
can reverse your manual correction by clicking Revert to Import. If you want to 
remove this record, click that button. 

Move through your database by clicking the Next Record or Previous Record buttons. 

 Adding Additional Records 

If you have last minute additions to your job, you can add these addresses to your 
database by entering them through the Lookup screen. Click the Add Record radio 
button and enter the address. Remember to click Correct and Address Save to ensure 
you are adding a cleaned address to your job. This step is appropriate for small number 
of additional addresses. If you have a larger number to enter, it might be more efficient 
to use the Address Management/Uncorrect option and merge another file into your job 
using File/Merge Into Job option. 

Correction/Validation 

Video 
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Validating a job ensures that your addresses are recognized by Canada Post. Each 
address is compared and matched against the Canada Post address database. 

You are provided with two options in iAddress™: 

• Correction and validation of your data 

• Validation only of your data 

 

 

 Correction and Validation 

Select “Correction/Validation” from the Address Management menu. The following 
screen will appear: 
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Mailing Date 

iAddress™ allows you to enter the date you will be mailing your job. It will correct and 
validate your job against the CPC data valid for that date. If you have chosen a non-
valid date, iAddress™ will display an error message. 

 Language Options 

The following options are available for language: 

• Automatic retains the language originally entered in the database 
by individual record. If an address has been entered partly in English and partly 
in French, iAddress™ calculates the language used predominantly within the 
record and assigns the language accordingly. 

• All English converts all addresses to the English equivalent. 
• All French converts all addresses to the French equivalent. 
• Language by Province will convert Quebec addresses to French and all other 

Canadian addresses to English. 
• Language Indicator will use the field designated as the Language Indicator 

field (set at job creation time) to determine the language of a record 
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 Formatting Options 

As well, the following options can be selected by clicking on the box in front of the 
option. To deselect, click again. 

• Machineable formats your address to meet the CPC criteria for machineable 
mail. This options forces the following formatting options. 

o Upper/Lower Case is set to off (Address all Upper Case). 
o Two Line Output is set to off (only a one line address is returned). 
o Use Accents is set to off (no accents returned). 
o Western Style is set to on (address is formatted to western style to 

increase readability) 

o Shorten Address is set to on (street types are abbreviated). 
• Upper/Lower Case converts addresses to UPPER and Lower case equivalents. 

***Important! 

UNLESS YOU CHOOSE THIS OPTION, ALL ADDRESSES WILL BE PRINTED IN 
UPPER CASE. 

 Address Line Formatting  

•  No Preference the software will select whichever format seems appropriate. 
•  Prefer 2 Line adjusts the database to a two-line format where it is allowed. For 

example: 

123 Main Street Apt 1000 
Oakville  ON  1A2 B3C 

becomes 
  
Apt 1000 
123 Main Street 
Oakville  ON  1A2 B3C 

•  Force 1 Line is available if you only imported one address line.  If the software 

prefers a two line output then the two lines will be joined into one field. 

  

•  Use Accents adds French accents to addresses when French has been 
selected. 

• Western Style formats your address to meet the CPC criteria for Western Style. 
It has no qualifier for apartment or unit numbers. For example: 

123 Main Street Apt 1000 
Oakville ON  1A2 B3C 
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becomes 
  
1000-123 Main Street 
Oakville ON  1A2 B3C 

•  Shorten Street converts addresses to the Canada Post approved short forms. 

• Update LVR standardizes large volume receiver names in your job. 

• Update Valids replaces a valid address with a formatted valid address. The 
format is determined by the options you have selected. For example: 

55 Trafalgar Court 

becomes 
  
55 Trafalgar Crt 

•  Minimum SERP Rural Standards The default in iAddress™ is to correct  rural 
addresses using very strict validation rules. If the Canada Post database 
contained PO Box information, that information was required to validate or 
correct the address. However, under SERP requirements, a rural address only 
needs to have the correct city and Postal CodeOM to be considered valid. 

• Space in Postal CodeOM formats your Postal CodeOM with a space after the first 
three characters: A1A 1A1. If this option is not selected, the Postal CodeOM will 
be formatted as A1A1A1. 

Validation Only 

Select “Validation” from the Address Management menu. You do not select language 
options with Validation only. 

 To Run Your Job 

After selecting all your options, click “OK”. 
To cancel your job while it is running, click “Cancel”. 

 To Undo the Correction 

To undo the correction, select “UnCorrect” from the Address Management menu 

Move Update (NCOA) 

National Change of Address (NCOA) 

NCOA is a pay-for-use service. To access this module, you will need to purchase 
transactions (1 transaction equals 1 processed address). These must be purchased 
directly through Flagship Software. 
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After performing duplicate extraction (optional), address correction and any other 
filtering on your job, you can process your addresses through the NCOA module. Your 
database must contain name fields as an address can only be matched if the name at 
the address is also a match. 

Video 

To start an NCOA job, select "Process NCOA/DNM" from the NCOA/DNM menu. 

 

 The following screen will appear: 
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Selecting Fields 

All fields in your database are listed so that you can locate and select the name fields 
you wish to use. 

• Separate Name Fields/Combined Name Fields: 

You can choose to have your name fields combined or separate. For 
example: 

  
 Separate Name Fields:        “Todd” “Martin” 

  
Todd is the first name and Martin is the second. 
  
 Combined Name Fields: “Todd Martin” 

  
The NCOA process will attempt to match either Todd Martin or Martin 
Todd at the given address. 

•  Company Name 
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If you have a company name in your database, use the drop down to 
select it here. 

  

Job Settings 

  
  

• Job Name 

This is the name that will appear on detailed reports to help identify different NCOA 
runs. 

• End User 

To run NCOA an end user terms of use ID must be used.  Select from this list the 
customer record whose ID you wish to use for this NCOA run. 

• Apply Matches / Purge Nixies 

Checking these options will cause the matches to be applied and nixies to be purged 
automatically after the NCOA run. 

• Run CMA 

If you choose to run DNM, the addresses in your database will be verified against the 
national Do Not Mail List. 

o Match First and Last Name - Match against the DNM database using first 
and last name as well as the address. (Preferred) 

o Match Last Name Only - Match against the DNM database using only the 
last name as well as the address. 

o Match Address Only - Match against the DNM database using only the 
address. 

• Purge DNM 

After processing your NCOA job, having this box checked will cause all the matched 
DNM records to be purged automatically. 

• Run in Secure Mode 

The option will cause the data to be encrypted during the transfer to the NCOA server. 
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Click Process to start your NCOA job. 

 

Running your Job 

• Once you have pressed the process button, the NCOA window will close and a 
progress bar will appear. The NCOA processing speed is dependent upon the 
speed of your computer, the speed of your connection and how many other 
people are processing NCOA at the same time as you. 

Important! 

• The Cancel button will allow you to stop processing NCOA part way through the 
job. Once canceled it may take a few moments to stop processing because your 
computer must inform the NCOA server so that you are not charged for records 
that you don’t receive. Any records that were processed before canceling will be 
charged against your account and are still valid. 

Important! 

• If you selected Purge DNM/Apply Matches/Purge Nixies, the viewing window will 
not appear after the NCOA job is processed. 
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Move Update (NCOA) 

National Change of Address (NCOA) 

NCOA is a pay-for-use service. To access this module, you will need to purchase 
transactions (1 transaction equals 1 processed address). These must be purchased 
directly through Flagship Software. 

After performing duplicate extraction (optional), address correction and any other filtering 
on your job, you can process your addresses through the NCOA module. Your database 
must contain name fields as an address can only be matched if the name at the address 
is also a match. 

Running Canadian NCOA 

To start an NCOA job, select "Process NCOA/DNM" from the NCOA/DNM menu. 
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The following screen will appear: 

 

Selecting Fields 

All fields in your database are listed so that you can locate and select the name fields 
you wish to use. 

• Separate Name Fields/Combined Name Fields: 

You can choose to have your name fields combined or separate. For 
example: 

  
 Separate Name Fields:        “Todd” “Martin” 

  
Todd is the first name and Martin is the second. 
  
 Combined Name Fields: “Todd Martin” 

  
The NCOA process will attempt to match either Todd Martin or Martin 
Todd at the given address. 
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•  Company Name 

If you have a company name in your database, use the drop down to 
select it here. 
 

Job Settings 

  

• Job Name 

This is the name that will appear on detailed reports to help identify different NCOA 
runs. 

• End User 

To run NCOA an end user terms of use ID must be used.  Select from this list the 
customer records whose ID you wish to use for this NCOA run. 

• Apply Matches / Purge Nixies 

Checking these options will cause the matches to be applied and nixies to be purged 
automatically after the NCOA run. 

• Run CMA 

If you choose to run DNM, the addresses in your database will be verified against the 
national Do Not Mail List. 

o Match First and Last Name - Match against the DNM database using first 
and last name as well as the address. (Preferred) 

o Match Last Name Only - Match against the DNM database using only the 
last name as well as the address. 

o Match Address Only - Match against the DNM database using only the 
address. 

• Purge DNM 

After processing your NCOA job, having this box checked will cause all the matched 
DNM records to be purged automatically. 

• Run in Secure Mode 

The option will cause the data to be encrypted during the transfer to the NCOA server. 
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Click Process to start your NCOA job. 

 

Running your Job 

• Once you have pressed the process button, the NCOA window will close and a 
progress bar will appear. The NCOA processing speed is dependent upon the 
speed of your computer, the speed of your connection and how many other 
people are processing NCOA at the same time as you. 

Important! 

• The Cancel button will allow you to stop processing NCOA part way through the 
job. Once canceled it may take a few moments to stop processing because your 
computer must inform the NCOA server so that you are not charged for records 
that you don’t receive. Any records that were processed before canceling will be 
charged against your account and are still valid. 

Important! 

• If you selected Purge DNM/Apply Matches/Purge Nixies, the viewing window will 
not appear after the NCOA job is processed. 
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Viewing and Applying the Results 

Once your NCOA job completes, if you did not select to automatically apply matches and 
purge nixies then the results viewing window will open.  To remove the nixie records from 
your database press the “Purge Nixie Records” button (3), to apply the changes that have 
been suggested by the NCOA process press the “Apply Changes” button(5), and to 
remove the DNM records press the “Purge DNM” button(7). 

Nixie records indicate that the occupant has moved but no new address is available for 
them. It is recommended that you remove nixie records from your job and update your 
main database. 

A sample report is shown below. As this is live data, names have been blocked. 

 
 

1.  This window displays the new address for your matches, the original addresses, 
and those that resulted from being corrected.  The “NCOA” column indicates the 
record type.  

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/Canada/NCOAview1.png?mtime=1483475341
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2nd Character 3rd Character 

U Unapplied F Family Move X Privacy 

A Applied I Individual Move M Move Back 

    
B Business Move C Changed by Canada Post 

    
N Nixie Record U Rural to Urban Address Conversion 

Other NCOA Codes 

UM Unmatchable – General Delivery, Invalid or No Name 

NM Non-Matched Record – Valid Address that does not appear in the NCOA 
database. (The person has not moved) 

 

Double-clicking a record in this table will highlight it and switch its Update 
column from ‘Y’ (yes update), to ‘N’ (do not update). Double-clicking again will 
return it to ‘Y’. 

2.  Allows you to view NCOA changes, nixie records or DNM records. 

3.  The “Purge Nixie Records” button will remove all nixie records from your 
database where the “Update” column is set to ‘Y’. 

4. Move to the NCOA Export screen. 

5. The “Apply Changes” button will update your job with the new addresses. Note 
that only records marked with ‘Y’ in the Update column will be affected.  
 

6. Move to the NCOA Export screen. 

7. The “Purge DNM Records” button will remove all the DNM records from your 
database where the “Update” column is set to ‘Y’. 

8. Move to the Export screen. 

9. Pressing the “Restore All” button will restore all the purged nixie and DNM records 
and reverse the NCOA changes that were applied. 

10. The “Close” button will close the window. 

11. The update column reflects which records will be purged or changed.  If the 
update field is set to ‘Y’ then the record will be purged or changed.  If the field is 
set to ‘N’ then the record will not be purged or changed. 
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Exporting NCOA Audit Table 

NCOA audit records are made up of the original values from your database, the 
changes made when the database was corrected and the changes that are suggested 
by NCOA.  

 
  

1) NCOA Values are the address updates due to moves.  Original values are the 
addresses in your database prior to correction. Corrected Values are addresses 
changed by the correction/validation process. 

2) These are the records to export.  There are three types of records, those that 
matched and have a change of address (Matches), those that matched but do 
not have a change of address (Nixies).  If you select all types it will select the 
nixies records and the matches. 

3) This drop-down list will allow you to select the type of database to export these 
records into. 

 

 

 

 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/Canada/NCOAview2.png?mtime=1483475344
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Activity Reports 

There are four types of reports currently available: 

 

 Monthly Detail / Summary 

Click on the report you wish to have displayed. This report will show the job dates, 

number of records processed, and the number of matched and nixie record. 

Geocoding 

Geocoding will add location information to the data in your current job.  The Geocoding 
menu option becomes available only after your job has been validated. The Geocoding 
screen has a few options for you to choose from. 

For the first option, you may choose signed, or unsigned degrees. 
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After choosing the type of degrees, you may simply press "Process" to have iAddress™ 
add the latitude and longitude information to your addresses. 

As an additional feature, iAddress™ can also use a list of Postal CodesOM and compare 
them to your addresses.  iAddress™ will return a list of the distance to the nearest Postal 
CodeOM out of that list provided.  You may add these Postal CodesOM from a separate file, 
or add them one at a time manually. 

To do this, check the "Create a distance list" option.  Next, type a Postal CodeOM you wish 
to add to the list into the text box and click "Add Postal Code". 
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A distance list may be created based on multiple Postal CodesOM as well.  This feature 
could be used by businesses who have multiple business locations and they want to mail 
to the closest addresses.These Postal CodesOM can also be added from a file.  To do this, 
click the "Add from File" button. 
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Select your file. 
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When the desired selection has been made, click the "Process" button to process your 
file.  

iAddress™ will let you know when the Geocoding has completed. 

  

To view the Geocoding results, click on the "View Database" option in the "File" menu. 

 

 

The Geocoding process adds extra columns to your data.  Scrolling to the right using 
the horizontal scroll bar you will eventually encounter these columns.  The columns are: 

• FLG_GEOLAT - The Latitude of the address' PC. 

• FLG_GEOLONG - The Longitude of the address' PC. 
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If you Geocoded with a PC list you will also find: 
 

• FLG_NEARESTPC - This is the nearest PC in the list to the address. 
• FLG_DISTANCE - This is the distance from the address' PC to the nearest PC 

from the list. 

 

 

 After you have your Geocoded results, you can use the filtering tool for targeted 
mailings. Under the Address Management menu, click on Filter Mailing, and choose the 
Geocode Filter: 

On this tab you can remove records from your database based on three options: 

• Remove the records that did not Geocode. 
• Remove records based on the distances that were generated from your distance 

list. 
• Remove a number of records starting from those closest or farthest away from 

the Postal CodesOM in your distance list. 

You can also view your geocoding report by clicking "Report" in the geocoding menu.  
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Your report will look something like this: 
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Presort 

Validation Report 
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Mailing Plan 

The Mailing Plan menu option generates a Canada Post specified mailing plan that can 
be imported into the Canada Post Electronic Shipping Tools through the online and 
desktop versions.  This file contains the required data to populate the electronic 
Statement of Mailing. 

After selecting Mailing Plan from the Presort menu you will be prompted to choose the 
directory in which you wish to save the file. (Note: The file should be saved in a folder 
that is accessible to the operator who submits the electronic Statement of Mailing) 



FLAGSHIP SOFTWARE LTD. MANUAL VERSION 4.0| 114  
 

 

Print All Reports 

Video 

After running the Presort function, several reports are produced. Several options are 
available to print these reports. 
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Selecting the Print All Reports option will produce the Statement of Mailing, 
Container/Bag and Bundle Report, as well as the Delivery Office Volume Summary. 
These reports can also be printed individually, by selecting the appropriate report from 
the Presort menu. The Validation Report is included on this screen should you wish to 
print or reprint this report. 

 Statement of Mailing 

The Statement of Mailing Report is described in detail in the Sortation section of this 
manual. However, should you need to access it after your initial sort, you can do so 
from the Presort -> Statement of Mailing menu option. 
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The Container/Bag and Bundle Report 

The Container/Bag and Bundle Report contains information about each container, bag 
or bundle, and its contents. You can access this report from the Presort menu. 
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Print the report by clicking the Print button or save the report to a text file. 

Some Canada Post RVUs require this report.  Please check with your local RVU (Office 
of Deposit) for its reporting requirements. 

To print this report for your records, click “Print”. 

Office Volume Summary 

Your Canada Post RVU may require the Delivery Office Volume Summary report. You 
can access this report from the Presort menu. 
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It describes the destination of the containers or bags in your job.   Please check with 
your local RVU (Office of Deposit) for their reporting requirements. 

Print All Labels 

Video 

Once the Sort is complete, you have several options for printing labels and reports. 
These options are available from the Presort menu. 
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Print All Labels 

By selecting this option, you can print all labels at once. This option is not 
recommended unless you are printing all labels to blank, non-perforated paper.  

  

Container/Bag Labels 

After your job has been sorted, you can view and print your container or bag labels in 
PDF using this option. A sample container label appears below. 

  

 Bundle Labels 
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You can view and print your bundle labels in PDF using this option. A sample bundle 
label appears below. 

 

Monotainer/ Pallet Labels 

You can view and print your Monotainer/Pallet labels in PDF using this option. A sample 
monotainer label appears below. 
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Sort 

Video 

The Sort function performs presort processing on your job, grouping mail by postal 
code and placing mail into containers as required, to take advantage of discounted 
postage rates. 

 

Select “Sort” from the Presort menu. The following screens will appear. 
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When all information has been correctly entered, click “Process”. 

If you perform the same sort on a file on a regular basis, you can save the details as a 
template. Select the correct settings and click “Save Template”. 

 Palletization/ Monotainers/ Brick Piling 



FLAGSHIP SOFTWARE LTD. MANUAL VERSION 4.0| 123  
 

Additional information is required when using pallets, monotainers or brick piling. You 
will be prompted to enter the length and width characteristics of your mailing if you 
choose one of these options. 

 Resort a Job 

If you wish to compare different sortation methods for your job, or if you made a 
mistake, you can select “UnSort” from the Presort menu. This will allow you to resort 
your job with different options. 

 Statement of Mailing 

The Statement of Mailing Report must be provided to Canada Post. It contains all the 
information required by Canada Post to verify your mailing. After selecting this report, 
you should verify the company information displayed. Any changes you make to this 
screen are temporary. To make permanent changes to the information on this screen, 
you must enter it from the Company Information screen on the File menu. 

 The next page has an example of how a Statement of Mailing might appear. 
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This report summarizes information on your mailing including specific data required by 
Canada Post for logistics purposes. It also lists the number of bundles, containers, and 
pallets or monotainers in your job. 

 Uncoded Pieces – Addressed Admail and Publications Mail 

Uncoded pieces in an Addressed Admail or Publications Mail job are addresses either 
missing a Postal CodeOM or containing an invalid Postal CodeOM. These pieces MAY NOT 
be included in your sorted job. They can be mailed separately via First Class mail or can 
be deleted from your job completely. To export the uncoded addresses before deleting 
them from your job, select the Export Database option form the File menu and click the 
Uncoded Addressess option. To delete the uncoded addresses from your job click the 
Delete Uncoded button on the Statement of Mailing screen. 

 Uncoded Pieces – Transactional Mail 

Uncoded pieces in a Transactional Mail (Incentive Lettermail) job are pieces that did not 
qualify for incentive rates under the density requirements. These pieces must be mailed 
at first class rates. You can export these addresses using the Export Database option 
from the File Menu and clicking the Uncoded Addresses option Your Address for Printing 
option from the main menu and clicking the Uncoded Addresses option. If you choose 
to keep the uncoded addresses in your job, they will be listed before the sorted records. 

Variable Weight/Thickness 
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This feature, found under the “Presort” menu, allows you to check the variable 

weight/thickness box so you do not have to input information every single time you run 

a job. The thickness and weight information should be written in the document used for 

the job so the software can automatically read it and apply the changes.  

Print 

Exporting Addresses for Printing  

To export your addresses, select Export Addresses for Printing from the Print menu. 

 

 

By selecting Export Database from the File menu or Export Addresses for Printing from 
the Print menu, the following screen will appear: 
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You may now select which addresses and/or additional fields you wish to export. 

• Only sorted records: Records which have been sorted. 
• Unsorted records to the end: Records that have not been sorted appear at 

the beginning of the file. 
• Extra Control Fields:  Fields created by iAddress™ during correction/validation, 

duplicate extraction, genderization, and sortation. 
• Add Original Address Fields:  Permits you to see the original state of your 

address fields as well as any corrections or changes 

• Include all other fields from original database:  Permits you to export 
additional fields contained in the original database (for example: customer 
numbers, phone numbers, etc.). 

After selecting your options, click Export Database. The following screen will appear, 
prompting you to provide a filename and location for your exported information. 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/PrintingYourAddresses/Export2.png?mtime=1456950388
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http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/PrintingYourAddresses/Export3.png?mtime=1456950207
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You may now select which addresses and/or additional fields you wish to export. 

• Only sorted records: Records which have been sorted. 
• Unsorted records to the end: Records that have not been sorted appear at 

the beginning of the file. 
• Extra Control Fields:  Fields created by iAddress™ during correction/validation, 

duplicate extraction, genderization, and sortation. 
• Add Original Address Fields:  Permits you to see the original state of your 

address fields as well as any corrections or changes 

• Include all other fields from original database:  Permits you to export 
additional fields contained in the original database (for example: customer 
numbers, phone numbers, etc.). 

After selecting your options, click Export Database. The following screen will appear, 
prompting you to provide a filename and location for your exported information. 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/PrintingYourAddresses/Export2.png?mtime=1456950388
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Windows Printing  

The Windows Print option allows you to design and print address labels using Avery 
Denison© label templates. Select Windows Print from the Print menu. 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/PrintingYourAddresses/Export3.png?mtime=1456950207
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The following layout screen will appear: 
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 Text boxes, indicias and graphics must be sized on the appropriate tab. The 
coordinates entered on each tab determine their position. You can see one page of 
labels or see an individual label by clicking the One Label tab. 

A text box (Text1) containing the address information from your job will automatically 
be produced. Text2 will contain the Bag/Bun information if you have run a sort. You can 
add up to three more text boxes that can contain fields from your database or text that 
you type in. 

Adding an Indicia 

To add an indicium to your label, click the Indicia tab. Select the type of mailing from 
the drop down menu. Enter the customer number, size and position where required. 

Adding a Graphic 

If you would like to add a graphic to your label, click the Picture tab. Click the Insert 
Picture tab and browse until you locate your file. Enter the size and position of the 
graphic where indicated. 

Dos Printing 
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The following screen will appear: 

 

Enter the required information and select Print. The following screen will appear: 
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Ensure the settings are correct for your printer and click Print. If you wish to enter your 
settings directly on the printer, select Ink Jet/No Driver. 

Tools 

Acronyms and Genderization  

To view a database, click on either Acronyms or Gender in the Tools menu. 
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A view of the database appears 

 

To add your own acronyms or names, choose the User Acronyms or User Gender and 
enter information into the fields. 

Postal Rates 

You may view the current postal rates by selecting “Postal Rates” from the Tools menu. 
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Select the rate you wish to view by clicking on the appropriate tab. You can also set the 
date for the pricing from the date box. 

iFuse (Canada Only) 

iFuse is located in the tools menu of iAddress™. 
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It can be accessed whether you have a job currently open or not.  If you have a job 
open and you select iFuse Reports then it will prompt you asking whether you would 
like to include the job you have open as one of the jobs in your fusion. 
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If you select yes then you will go through the save job process and then iFuse will 
launch. 

 
iFuse works by selecting multiple iAddress™ jobs and creating a series of merged 
reports.  To select a job or series of jobs to include in the fusion select the "Add Jobs to 
List" button located in the top right.  

There are no restrictions on the jobs that can be included in the list, however, the jobs 
need to have similar qualities to be able to create a combined report from them. 

There are 3 combined reports we create, the validation report, the statement of mailing 
and the mailing plan (for upload to Canada Post).  The validation report has the least 
restrictions, it only requires the the jobs be corrected.  The statement of mailing and 
the mailing plan require that the following parameters match between jobs: 

• Mail on behalf of - name, address and number 

• DMD dates (i.e. sorted using the same data) 

• Deliver Mode Audit Code (same as the dates, we require the same data be used) 

• Office of Deposit (All your mail needs to be dropped off at the same place) 

• Mailing Date (All your mail needs to be dropped off on the same day) 

• Piece Type (No mixture of letter and oversized) 

• Container Type (Essentially the same type of sort is being done on different jobs) 

• Tax Rate 
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To generate the reports you click the "Next" button and you will see the report selection 
screen. 

 

By checking or un-checking the report boxes you can choose to produce some or all of 
the reports.  The filenames are the names of the reports that will be created. 

Label2CSV (Canada Only) 

Label2CSV is a stand-alone utility designed to convert label files to .csv files. These .csv 
files can then be used to create mailings with iAddress™. Label2CSV can also be used 
to clean files in .csv format. This is useful if you have a file with address components 
scattered across a record, rather than consistently placed within fields. 

This is an example of a label file: 

  

JOHN SMITH 

100 MAIN STREET 

TORONTO, ONTARIO 

M2N 1N5 

  

CINDY SMITH 

15 DOVER ROAD 

BURNABY, BRITISH COLUMBIA 

V2T 1T2 

  

RODNEY SMITH 

38 RIVER LANE 

HALIFAX, NOVA SCOTIA 

B7T 8A9 
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To convert a label file to a .csv, select Programs/iAddress™/Label2CSV from the Start 

bar. The following screen will appear: 

 

After clicking the “Label2CSV” button, you will be prompted for the directory containing 
the label format file. 

After selecting the appropriate file, click “Open”. You will then be asked for a file name 
and location for the resulting .csv file. Enter this information and click “Save”. 

By default, the “Do FixCSV after conversion” is checked. When this feature is enabled, 
the utility attempts to identify address lines, city, province and Postal CodesOM, and 
place them in the first five columns of the resulting .csv file. 

For non-label format files 

To use this utility for a non-label format file, the file must first be saved in .csv format. 
This can be done using a “Save As” with the program the file was created in. 

 After opening the Address Miner, click the “FixCSV” button. You will be prompted for 
the filename and its location. After supplying this information, you will be prompted for 
the filename and location of the resulting .csv file. 

Address Miner 

Address Miner is a more complex version of the FixCSV option using Canada Post data 
and more advanced algorithms. 

 
 
 
 
 
 
 
 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/Tools/AddressMiner1.png?mtime=1457379069


FLAGSHIP SOFTWARE LTD. MANUAL VERSION 4.0| 140  
 

Downloading Updates 
 
Registration is successfully completed, you can download the latest databases by 
choosing "Download Updates" from the "Tools" menu. 
 

 
 
From the “Download Updates” window click "Download". 
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The “Available Data Files” window will appear. Select "Download updates only" to 
download and install any software updates for iAddress™.  Otherwise, select the 
appropriate data and click “Ok” 
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When the download is complete, iAddress™ will be shut down to complete the 

update.  You will be prompted to save any unsaved work. 

Note: 

It can take a few minutes to decompress the data files. 

When the update is complete, iAddress™ will be restarted. 

For your convenience, here is the download link from which to download the iAddress™ 
software: 

www.flagshipsoftware.com/iaddress-setup.exe 

QR CODE CAMPAIGN 

Flagship Software offers the QR Code utility; a quick and easy way to enhance and 
track the performance of your marketing campaigns. iAddress™ will enable you to print 
a QR Code on your advertising piece which will gather data to enable trackability and 
the response of the open rate of your marketing campaign. 

http://www.flagshipsoftware.com/iaddress-setup.exe
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If you click "Mange QR Campaign" you can keep track of all your campaigns and create 
new campaigns on this screen: 

 

You can view reports when you click on "View Campaign Reports" a screen will appear: 
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When you click "QR Encode Existing Field" you can manage your current campaign by 
adding variable or static data and a QR code line separator if you wish on this screen: 
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CA unaddressed 2D Barcode (C73) 

You can create a unaddressed 2D Barcode by going to the "Tools" menu and clicking on 
"CA unaddressed 2D Barcode (C73)". 

 

Fill in all your information in the fields below and click "Process" 
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Help Menu 

Welcome to the help menu! If you click "Help Content" it will bring you to this 

online manual. The online manual can be used to solve problems which do not require 
customer support.  

 

Our newsletter is available in the help menu, simply click "Newsletter". We publish our 
newsletter monthly. It contains news about all our software updates and more. The 
newsletter is available both in English and French. Enjoy! 
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If you would like support via email click "Email Support". A window will pop up and you 
can simply fill out the form and send an email to our support staff. 
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If you would prefer to receive remote support. Please click "Remote Support". A 
window will pop up containing a code which you will need to provide to our support 
staff so they can remote into your computer and help you. 
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If you would like to know the version of your software, please click "Version". A window 
will pop up, here you can see the version of each program you have on your device. 
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To re-register your information please click "re-register". A window will pop up, you 
must simply fill out the form and submit. 
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If you would like to know more information about iAddress™ please click "About". Here 
you can read about iAddress™ in the pop up window in both English and French.  
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U.S.A 

Sorting your U.S Mail 

U.S. Sortation 

The sort function will perform presorting on your mailing to take advantage of bulk rate 
discounts with USPS. 
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The following screen will appear. When all the steps are completed, iAddress™ will sort 
your mailing. 



FLAGSHIP SOFTWARE LTD. MANUAL VERSION 4.0| 155  
 

 

On this first screen, select your mailing date and the customer information that is to 
appear at the top of the postage statement.  You must choose one of permit holder, 
mailing agent or mail owner to use their mailer ID for the intelligent mail barcode 
(IMB).  To enter a mailer ID and CRID for a customer, see the section on entering 
customer information. 

Note: 

The Intelligent Mail Barcode option only works if you have a mailer ID and CRID that 
you can acquire from USPS through the business customer gateway. 
 

The following step allows you to choose options related to Mail Class, Piece Type, 
Container Type, and Pallets. 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/USA/sort02.png?mtime=1460563769
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Clicking on the "Advanced Pallet Options" will take you to the second screen where you 
can select special pallet preparations such as merging, reallocation and setting a 
minimum for no-minimum pallets. 

• No minimum pallets: 

A no minimum pallet is a pallet defined in the DMM as having no minimum number of 
pieces.  By default, these pallets are filled to 500lbs so as not to create large numbers 
of minimally filled pallets but since there is no official minimum by setting a different 
value you can create more higher value pallets with less pieces. 

• Create Merged Pallets: 

A merged pallet can be created based on two different sets of rules.  A merged pallet 
might be created when there is a number of pieces that could form undersized high 
value pallets by making a single high value pallet of proper size.  The larger the mailing 
the more likely that a merged pallet can be created. 

• Generate Reallocation Pallets: 

A reallocation pallet can steal pieces from higher level pallets to create a lower level 
pallet by combining these stolen pallets with pieces in residue. 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/USA/sort03.png?mtime=1460563769
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The next screen deals will Mail Processing options.  These options will change in 
availability based on your previous choices.  

 

The first screen will give you the optimal settings for doing your mailing that should 

produce the best value; the options used will be listed below.  If you want to adjust one 
of the parameters you can select the "Advanced" button and select all the parameters 
manually. 

The next screen allows you to enter your piece parameters like length, width, weight, 
thickness, and lets you choose your office of deposit. 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/USA/sort04.png?mtime=1460563769
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It is recommended that you take 10 pieces and make those measurements for weight 
and thickness as these affect the fill rates on trays, sacks and pallets. 

Depending on your mailing type, you may change the options on the next screen.  In 
case you are doing a nonprofit mailing, you can select that option, and enter your 
nonprofit number here.  

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/USA/sort05.png?mtime=1460563769
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If you are doing a Periodical Mailing, please enter the appropriate information here.  If 
you do not have publication information set up, then you will need to do that in the 
customer information screen of iAddress™. 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/USA/sort06.png?mtime=1460563769
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The last screen this is where you set the fills for bundles, containers, and 
pallets.  Depending on previous choices the screen will vary slightly. 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/USA/sort07.png?mtime=1460574748
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If you are creating an electronic file, mail.dat or Shipping Services file, then you will be 
able to set the options on the following screens. 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/USA/sort08.png?mtime=1460574748
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The mail.dat screens will allow you to select full service or basic service and set your 
service type code.  There is no restriction on which service type code you can enter so 
please be sure you are entering the correct code for the service you are requesting. 
  
Once you have completed all the sort setup you will be presented with the summary 
page.  Confirm your selections and your sort will start.  You can also save the template 
on this screen. 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/USA/sort09.png?mtime=1460574749
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After the sort is complete, the following screen will appear: 

 
  

If you would like a combined report document, enter the number of each report type in 
the appropriate text boxes.  By default, "Collate Reports" is unchecked, which means 
that multiple generated copies of the same report will be grouped together.  Selecting 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/USA/sort10.png?mtime=1460574749
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"Collate Reports" will instead order them in series. Click "Generate Reports" to generate 
the pdf. 

By clicking "Generate Reports", iAddressTM will generate the number of reports that are 
entered beside each report type. Once the reports are finished 
generating, iAddress™ will open the generated pdf for you. 

US NCOA Processing (NCOALink®) 

US NCOA Processing (NCOALink® ) is available through the  iAddress™  US 
software.  NCOALink® is offered as an unlimited service for an annual fee. 

 Before Processing NCOALink® 

 In order to use NCOALink® , you will require the following: 

1. 1) A signed Processing Acknowledgement Form (PAF) for each list owner 
requesting NCOALink®   service.  These agreements renew annually.  If you are 
the list owner, you will require your own PAF 

2. 2) A Letter of Intent (LoI) is required for each non-US list owner.  USPS must 
approve the LoI for each non-US list owner before processing is permitted. 

3. 3) A PAF ID will be issued for each List Owner.  For non-US mailers, this PAF ID 
will be issued once USPS has approved Processing.  Flagship Software will notify 
you once a PAF ID has been issued. Each PAF ID must be added to your 
Company Information/Customer Information tab.  If you are the list owner, you 
will need to enter yourself as a customer 

 Entering a PAF ID 

From the File menu, select “Company Information”.  Add List Owner information, 
including contact information, permit and assigned PAF ID.  Click OK to save your 
information. 
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Starting NCOALink® 

To start NCOALink®, you must create a job in iAddress™ and run 
Correction/Validation.  After correction is complete, the “Process NCOAlink®” option will 
be enabled on the NCOAlink® menu.  Clicking "Process NCOAlink®" will start the 
wizard covered in the "Running an NCOALink® Job" section next in the manual. 

Running an NCOALink® Job 

To process your job through NCOALink® , you must provide the name fields for your 
job.  An address can only be matched if the name at the address can also be matched. 
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 Field Selections 

The screen will display all fields in your job.  This allows you to locate and select your 
name fields for processing NCOALink® 

iAddress™ offers you two ways to select your name fields: 

• “Combined Name Fields” option allows you to select and de-select name 
fields from the “List of Fields” by double-clicking on them. This will add them into 
the names box. Using this method, the program will determine the name fields 
automatically. However, a name like [Martin Todd] or [Todd Martin] will be 
considered equivalent.  

• “Separate Name Fields” allow you to specifically select fields. 

TIP: 

If the company name is listed in a separate field it can be selected to increase the 
chance of a successful business move match. 

 
 
 
Options Screen 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/USA/NCOARun1.png?mtime=1457470873
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• Office of Deposit: The office of deposit information is required to do the NCOA 
process.  Typing in the Zip CodeTM should automatically populate the City and 
State fields for you. 

• The US NCOA Matching Criteria: You may choose the match criteria to be 
any combination of Individual, Family, and Business matches. 

• Auto Apply Matches: Selecting this option will automatically apply the matched 
data to the file. 

• Auto Purge Nixies: Selecting Auto Purge Nixies will have Nixie matches 
automatically removed. 

• The Customer Name and PAF ID: These options must be selected from the 
list.  This list references the Customer Information entered in the Customer 
Information screen. 

• Save Transaction Report: This option will save the transaction report as soon 
as the process is done. This works in both modes and saves you the step of 
selecting "Report" from the main menu. 

The Export Window 

 If you are using the Job Wizard, this Export screen will appear: 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/USA/NCOARun2.png?mtime=1457470894
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If you are using the Interface Feature, this Export screen will appear:  
 

 

http://www.flagshipsoftware.com/manual/media/blogs/manual/quick-uploads/manual/Images/USA/NCOARun3.png?mtime=1457470907
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•  NCOA Values are the address updates due to moves. 
• Original values are the addresses in your database prior to correction. 
• Corrected Values are addresses changed by the correction/validation process. 
• Types to Export:  There are three types of records, those that matched and have 

a change of address (Matches), those that matched but do not have a change of 
address (Nixies), and those that matched an estate record (Estates).  If you 
select all types it will select the nixies records, the matches, and the estates. 

• Export Type drop down: This drop-down list will allow you to select the type of 
database to export these records into. 

  

The NCOALink® records are made up of the original values from your database, the 
changes made when the database was corrected and the changes that are suggested 
by NCOALink®. 

 

 

There are two types of NCOALink® Reports availible in iAddress™. 
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Activity Report 

You can print a report summarizing your job by selecting Reports from the 
NCOALink®  menu.  You can view a summary of your activity for the past 1, 3 or 12 
months by selecting Activity Report from the NCOALink®  menu. 

 

 Account Status 

Your account status screen will show Canadian NCOA and US NCOALink®  information. 
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It will look something like this: 

 

Automation 

Command Line Options 

iAddress™ offers powerful automation functionality that allows for you to easily and 
flexibly automate your address management processes. Using job configuration files, 
you can specify all the details of how your job is run – from the input files to the 



FLAGSHIP SOFTWARE LTD. MANUAL VERSION 4.0| 172  
 

correction parameters to the output files. By command line options, you can override 
the config file options found in the next section specific to job and merge file numbers. 

There is a limit of 8192 characters on the command line. 

Format: 

iAddress.exe filepath\filename.cfg [-logfile=_filename][-existingoutput={datestamp 
(default), error, overwrite}][-KEEP_IADDRESS_OPEN={Y(default),N}] [-
J#][_FIELDNAME=_FIELDDATA][-F#][_FIELDNAME=_FIELDDATA] [-CADATE] [-
USDATE] 

Example:  
iAddress.exe “c:\work\config\job1.cfg” 

 

It is important to note: 

-J# (Job Number) must be specified for all _FIELDNAME=_FIELDDATA that is relevant 
to a job. 

 -J# (Job Number) and -F# (Merge file Number) must be specified for 
_FIELDNAME=_FIELDDATA that is relevant to both a merge file and a job until -J# or -
F# is re-specified the same value for J# and F# are assumed for all 
_FIELDNAME=_FIELDDATA that follow. 

 If J# is re-specified then F# is cleared. 

 Job numbers start at value 1 and increase. 

 Merged file numbers start at value 0 and increase. 

 The jobs and files are ordered the same way they were first selected in iAddress™. 

  

Command Line Parameters 

-logfile 

Usage:  

-logfile=”full/path/to/file.log” 

Example:  
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iAddress.exe “c:\work\config\job1.cfg” -logfile=”c:\work\logs\job1.log” 

Description:  

By default, the log is written to the same folder that iAddress™ resides in 
(On a typical installation this is C:\Program Files\iAddress on a 32-bit OS; 
C:\Program Files (x86)\iAddress on a 64-bit OS). The log is named 
automate.log and is overwritten on subsequent runs. By using this 
parameter you can redirect the log output and gain some control over log 
storage. 

-quiet 

Usage:  

 -quiet 

Example:  

 iAddress.exe “c:\work\config\job1.cfg” –quiet 

Description:  

This parameter causes iAddress™ to suppress Message Dialogs. While 
running in Quiet Mode, all dialogs that notify of a critical error in the 
application flow will cause iAddress™ to fatally exit with an error code of 1 
(which can be checked in a batch file). All message dialogs are logged to 
the logfile (regardless of this parameter). 

-existingoutput 

Usage:  

 -existingoutput={datestamp, overwrite, error} 

Example:  

 iAddress.exe “c:\work\config\job1.cfg” –existingoutput=overwrite 

Description:  

This parameter controls how iAddress™ handles the scenario when 
defined output files (Such as the save job,        labels or reports) already 
exist on the file system. The default is to datestamp the existing file. 

Datestamp: Prepends the existing file with the creation date of the file, 
or the current date and time if it is unable to determine the creation date. 



FLAGSHIP SOFTWARE LTD. MANUAL VERSION 4.0| 174  
 

Overwrite: Overwrites the existing file. This will cause all the existing 
files to be deleted prior to iAddress™ running the job. 

Error: Causes iAddress™ to trigger a fatal error before the job is run. 

-KEEP_IADDRESS_OPEN 

Usage:  

-KEEP_IADDRESS_OPEN={Y(default),N} 

Example:  

iAddress.exe “c:\work\config\job1.cfg” –KEEP_IADDRESS_OPEN=N 

Description:  

This parameter controls whether iAddress™ remains open after the job is 
done. 

-J# 

Usage:  

-J# [_FIELD_NAME]=[_FIELD_DATA] 

Example:  

• iAddress.exe “c:\work\config\job1.cfg” –J1  

• iAddress.exe "c:\work\config\job1.cfg" -J1 
STANDARD_MAILING_DATE=2011-01-01 -F0 
INPUT_FILE=C:\foo\file.xls  

Description:  

This parameter represents a job number and must be specified for all 
_FIELDNAME=_FIELDDATA that is relevant to a Job. See "Important to 
note:" section above for more information on the usage of -J#. See also 
the config file options section for fieldnames and data. 

 

-F# 

Usage:  

 -F# [_FIELD_NAME]=[_FIELD_DATA] 
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Example:  

• iAddress.exe “c:\work\config\job1.cfg” –F0  

• iAddress.exe "c:\work\config\job1.cfg" -J1 
STANDARD_MAILING_DATE=2011-01-01 -F0 
INPUT_FILE=C:\foo\file.xls  

Description:  

This parameter represents a Merged file number and must be specified for 
all _FIELDNAME=_FIELDDATA that is relevant to a merged file. See 
"Important to note:" section above for more information on the usage of -
F#. See also the config file options section for fieldnames and data. 

-USDATE 

Usage:  

 -USDATE 

Example:  

• iAddress.exe “c:\work\config\job1.cfg” –USDATE  

Description:  

This option creates a file in the execution path called "USDATE.tab".  This 
file contains the start and end dates of the US mailing data currently 
loaded on your system. USDATE.tab is a tab delimited file. This 
information can be used to determine if you have the data for the mailing 
date that you have chosen. 

-CADATE 

Usage:  

 -CADATE 

Example:  

• iAddress.exe “c:\work\config\job1.cfg” –CADATE  

Description:  

This option creates a file in the execution path called "CADATE.tab".  This 
file contains the start and end dates of the Canadian mailing data 
currently loaded on your system. CADATE.tab is a tab delimited file. This 
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information can be used to determine if you have the data for the mailing 
date that you have chosen. 

Config File Options 

Comments 

All Comment in the cfg file are started with #. Any line that begins with this tag are not 
read or processed. 

 Start of Job 

This section will always appear at the top of each job. Multiple jobs can be listed in a 
cfg file and the START parameter will increment for each job. 

START=The start number of this job 1+ 

JOB_NAME=name of the job 

STANDARD_MAILING_DATE=YYYY-MM-DD 

NUMFILES= The list of the number of files that will be merged in 0+ 

SEED_RECORD=Can be placed multiple times indicating index of seed group to use. 

  

  

File Input 

This section can be repeated for a number of times equal to the number of files you 
want to merge in. The FILE parameter will be incremented for each file. 

FILE=The start number of this file 0+ 

INPUT_FILE=Full path of the input file. 

DONT_EXPAND_FIELDS=Y/N - On input do you want the field size maintained? (fixed 
length/dbf) 

CURRENTABLENAME=The name of the table you want input? (files with tables) 

TAB_DELIMITED=Y (text files) 
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FIXED_LENGTH_TEMPLATE=file path of the template to use for fixed length import. 
(text files) 

SPECIFY_DELIMITED=The symbol used to delimit the file (text files) 

IS_HEADER_ROW=Is the first row a header row (text and excel files) 

ALL_FIELDS_AS_TEXT=Y/N -Load all columns in your text file as a text data type. 

  

ADD_COLUMN=Map the first address field 

ADD2_COLUMN=Map the second address field 

CITY_COLUMN=Map the city field (separate fields only) 

PROV_COLUMN=Map the province or state field (separate fields only) 

PC_COLUMN=Map postal code or zip code field (separate or combined city/prov only) 

CITY_PROV_COLUMN=Map the combined city/prov or city/state field (combined 
city/prov only) 

CITY_PROV_PC_COLUMN=Map the combined city/prov/pc or city/state/zip field. (all 
combined) 

  

All the name fields are optional and are used for the purposes of duplicate detection. 

  

FNAME_COLUMN=First Name 

LNAME_COLUMN=Last Name 

NAME1_COLUMN=Alternate matching field 

NAME2_COLUMN=Alternate matching field 

NAME3_COLUMN=Alternate matching field 

LANG_COLUMN=For correction, determines the language of a record if language by 
field is chosen. 
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Correction Options 

CORRECT=Y/N – Do you want a correction performed, if N then skip all other correction 
instructions 

VALIDATION_ONLY 

USE_PREFERRED_CITY_NAME 

UPPER_LOWER_CASE=Y/N – N will upper case the address, Y will create mixed case 
addresses. 

TWO_LINE_OUTPUT=Y/N – will prefer two lines, N will have no preference 

FORCE_ONE_LINE=Y/N – will force the two address lines together 

USE_ACCENTS=Y/N – will use accents on words when french is the selected language. 

WESTERN_STYLE=Y/N – unit number precedes the street number and is connected by 
a dash. 

MACHINEABLE=Y/N – Forces CPC criteria for machinable mail. 

SHORTEN_ADDRESS=Y/N – Use the shortened form of the address, i.e. Street -> st 

UPDATE_LVR=Y/N – Standardizes large volume receiver names in your job. 

UPDATE_VALIDS=Y/N - Update valid addresses with the formatting options. 

SPACE_PC=Y/N – Place a space in the middle of the postal code. 

MIN_SERP_RURAL=Y/N – Use the SERP minimum standards for correcting rural 
addresses. 

CITY_LENGTH= (13, 18, 40, 0) – Defines the number of characters to limit. 0 means no 
limit. 

LANGUAGE=A text definition of how you want the address correction to handle 
language: 

AUTOMATIC – Detect the language of the address and use the same language. 
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ALL_ENGLISH – Switch all addresses to CPC english conversion. 

ALL_FRENCH – Switch all addresses to CPC french conversion. 

BY_PROVINCE – Switch all addresses in Quebec to CPC french conversion otherwise 
english. 

BY_INDICATOR – Use the language conversion specified by the language field mapped. 

  

LANGUAGE_FIELD=The name of the field that will be used to determine language by 
indicator. 

(overrides LANGUAGE if populated) 

ENGLISH_SYMBOL=The character in the language field that indicates english. 

(requires LANGUAGE_FIELD be populated) 

FRENCH_SYMBOL=The character in the language field that indicates french. 

(requires LANGUAGE_FIELD be populated) 

  

  

Geocoding Options 

GEO_DO_GEOCODE=Y/N – Do geocoding on this job or not. 

GEO_NUMERIC_DEGREES=Y/N – Display numeric degrees (Requires Alpha be the 
opposite) 

GEO_ALPHA_DEGREES= Y/N – Display alphabetic degrees (Requires Numeric be the 
opposite) 

GEO_COMPARE_PCS=Comma separated list of postal codes to compare during coding. 

GEO_EXCLUDE_UNCODED=Filter records that could not be geocoded. 

Closer and Farther have priority over distance filtering. If they are both included then 
only filtering by closer than and farther than will be applied. 
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GEO_CLOSER_THAN=Filter postal codes closer than this value in kilometres (exclude if 
not used) 

GEO_FARTHER_THAN=Filter postal codes farther than this value in kilometres (exclude 
if not used) 

GEO_NUM_PIECES=Number of pieces to keep after distance filtering 

GEO_FARTHEST= Y/N distance filtering on farthest or closest 

  

  

NCOA Options 

NCOA_DO_NCOA=Y/N – Run the NCOA process or not. 

NCOA_DNM_ONLY=Y/N - Run the do not mail process without running NCOA 

(Requires NCOA_DO_NCOA=N) 

NCOA_CDL_ONLY=Y/N - Run the deceased list process without running NCOA 

(Requires NCOA_DO_NCOA=N) 

NCOA_DO_NCOA_TEST=Y/N – Run the NCOA process in test mode (override 
NCOA_DO_NCOA) 

NCOA_APPLY_MATCHES=Y/N – Apply the matches to your list after processing is 
complete. 

NCOA_PURGE_NIXIES=Y/N – Purge the nixies from your list after processing is 
complete. 

NCOA_RUN_DNM=Y/N – Run the do not mail process. 

NCOA_PURGE_DNM=Y/N – Purge the do not mail records from your list after 
processing is complete. 

NCOA_DNM_MATCH=Number indicating matching options for do not mail. 

0 – Match the First and Last name as well as the address. (suggested) 
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1 – Match using the Last name and address only. 

2 – Match using only the address. 

NCOA_RUN_CDL=Y/N – Run the deceased list process. 

NCOA_PURGE_CDL=Y/N – Purge the deceased list records from your list after 
processing is complete. 

NCOA_FIELDS_COMBINED=Y/N – The names are combined in a single field. 

NCOA_COMBINED_TEXT=A list of field names to combine, enclosed by square brackets. 
[a] [b] [c] 

(Requires NCOA_FIELDS_COMBINED=Y) 

NCOA_FIRST_NAME=The name of the field containing the first name, can be blank. 

(Requires NCOA_FIELDS_COMBINED=N) 

NCOA_MIDDLE_NAME=The name of the field containing the middle name, can be 
blank. 

(Requires NCOA_FIELDS_COMBINED=N) 

NCOA_LAST_NAME=The name of the field containing the last name, cannot be blank. 

(Requires NCOA_FIELDS_COMBINED=N) 

NCOA_NAME_SUFFIX=The name of the field containing the name suffix, can be blank. 

(Requires NCOA_FIELDS_COMBINED=N) 

NCOA_COMPANY_NAME=The name of the field containing the company name, can be 
blank. 

(Requires NCOA_FIELDS_COMBINED=N) 

NCOA_PRINT_TRANSACTION_REPORT=Define the printing/saving of the transaction 
report. 

0 – Do Nothing 

1 – Print only 
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2 – Save only 

3 – Print and Save 

NCOA_PRINT_PRINTER_NAME=Exact name of the printer to print from. 

NCOA_PRINT_BIN_NUMBER=The bin number on the printer to print from. 

NCOA_PRINT_TRANSACTION_FILENAME=Complete path in which to save the 
transaction report. 

NCOA_EXPORT_WHICH_EXPORT=Define the type of export for the NCOA audit table. 

0 – Export All 

1 – Export just the nixies. 

2 – Export just the matches. 

NCOA_EXPORT_NCOA_VALUES=Y/N - Export the forwarding address (does not apply to 
nixies) 

NCOA_EXPORT_ORIG_VALUES=Y/N - Export the original values when the file was 
imported. 

NCOA_EXPORT_CORR_VALUES=Y/N - Export the values as they appeared after 
correction. 

NCOA_EXPORT_DNM_VALUES=Y/N – Export the CMA values (requires CMA be run) 

NCOA_EXPORT_FILENAME=Complete path in which to save the export file. 

NCOA_EXPORT_TYPE=Text defining the type of output. 

"Access 2000", "Access 97", "DBase III", "DBase IV", "DBase V", "Excel 4.0", "Excel 
5.0", 

"Excel 97", "Tab Delimited", "Comma Delimited", "Specify Delimiter", "Fixed Length" 

NCOA_EXPORT_HEADER_ROW=Y/N – Use a header row on export (text export only) 

NCOA_EXPORT_QUOTES=Y/N – Surround the fields with double quotes (text export 
only) 

NCOA_EXPORT_DELIMITER=Delimiter used, (i.e. ,) (text export only) 
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NCOA_ENDUSER=The name of the end user customer as it appears in your customer 
list. 

NCOA_ENDUSER_TOUS=This overrides the TOUS ID entered in the customer record  
     (manual entry, required with NCOA_SERVICEPROVIDER_TOUS) 

NCOA_SERVICEPROVIDER_TOUS=This overrides the TOUS ID in the company record  
     (manual entry, required with NCOA_ENDUSER_TOUS) 

  

  

Sortation Options 

SORT=Y/N – Perform the sort with no conditions (supercedes SORT_ONLY_IF_95) 

SORT_ONLY_IF_95=Y/N – Perform the sort if correct and valid pieces are 95 percent of 
list. 

MAIL_TYPE=Defines the type of sort to perform. All following options vary based on 
this value. 

Valid values: 

PERSONALIZED_SPECIAL_HANDLING 

PERSONALIZED_MACHINEABLE 

PUBLICATION_SPECIAL_HANDLING 

PUBLICATION_DFP 

PUBMAIL_MACHINEABLE 

LETTERMAIL_MACHINEABLE 

  

MACHINEABLE_LABELS_ONLY=Y/N – Y for machinable mailings only, does not sort. 

MACHINEABLE_LABELS_ONLY_NUMBER_OF_CONTAINERS= 

The number of container labels to print (Requires MACHINABLE_LABELS_ONLY) 
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MACHINEABLE_LABELS_ONLY_NUMBER_OF_PALLETS= 

The number of pallet labels to print (Requires MACHINABLE_LABELS_ONLY) 

MACHINEABLE_LABELS_ONLY_FILL_PAGE=Y/N 

Fills the container labels page, 4 per page. (Requires MACHINABLE_LABELS_ONLY) 

UNCODED_AS_MACHINEABLE=Y/N 

Any pieces that cannot be included are sent as machinable (Requires INCENTIVE_LCP) 

ENVELOPE_WEIGHT=The weight of the piece in grams. 

ENVELOPE_THICKNESS=The thickness of the piece in mm. (shortest side) 

PIECE_LENGTH=The length of the piece in mm. (longest side) 

PIECE_HEIGHT=The height/width of the piece in mm. (second longest side) 

BAG_WEIGHT_MAX=The maximum weight of the container you are using. (Must be 
exact) 

Flat Tub = 21 Letterflatainer = 21.705 

BUNDLE_MAX=The maximum number of pieces in a bundle (max in container for 
machinable sorts) 

CONTAINER_MAX=The maximum number of pieces in a container. 

CONTAINER_TYPE=The type of container being used. (must be appropriate for piece 
and sort) 

FLATTUB LETTERFLATAINER 

BRICK_PILE_PIECES_PER_PALLET_MIN=The fewest pieces to place on the pallet. 

BRICK_PILE_PIECES_PER_PALLET_MAX=The most pieces to place on the pallet. 

MAIL_SIZE=Defines the type of piece you will be preparing. Must use one of the 
following: 

1. STANDARD 
2. OVERSIZED 
3. DIMENSIONAL 
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MONOPAL_TYPE=The type of pallet being used, empty if none. 

MONOTAINER 

PALLET 

OFFICE_OF_DEPOSIT=The name of the office of deposit 

OFFICE_OF_DEPOSIT_PC=The postal code of the office of deposit. 

OFFICE_OF_DEPOSIT_SITE_NUMBER=The site number for this office of deposit if it 
exists. 

PHANTOM=Y/N – Will you be creating a phantom mailing (less than 1000 pieces, 
boosted to 1000) 

TIME_COMMITTED=1/0 – use the time committed (1). 

OEL_ON_FRONT_AND_END=Number indicating the positioning of the OEL in a bundle. 

4001 – First piece of the bundle 

4002 - Last piece of the bundle 

4003 – First and last piece of the bundle 

4004 – All pieces in the bundle 

OEL_STARS_POSITION=A word describing where the stars in an OEL should be placed 

FIRST LAST FIRST_AND_LAST 

OEL_NUM_OF_STARS=The number of stars to place on the OEL. 

BUNDLE_BREAK_CHAR=The character to use to define when a bundle changes. 

CONTAINER_BREAK_CHAR=The character to use to define when a container changes. 

PALLET_BREAK_CHAR=The character to use to define when a pallet changes. 

**BREAK_IN_BAGBUN_COLUMN=Y/N – Add the bundle break character to the BAGBUN 
field. 

TAX_RATE=The valid tax rate where the mail is being deposited. 
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CA_CLIENT_INFORMATION=The customer name exactly as it appears in your customer 
list. 

CUSTOMER_REFERENCE=The customers reference number. 

DO_BRICK_PILING= Y/N – Do brick piling in this mailing. 

BRICKLEVEL3=Y/N – Use brick piling level 3. 

BRICKLEVEL4=Y/N – Use brick piling level 4. 

BRICKRESIDUE=Y/N – Brick pile the residue pieces. 

**TENPCTMINPALLET=Y/N – Use the 10 percent minimum on brick piled pallets 
(restricted by drop point) 

USE_RETIRED_PC=Y/N – Use postal codes for sorting that have been retired by CPC. 

SORT_UNCORRECTABLE=Y/N – Include uncorrectable addresses in sort. 

SORT_QUESTIONABLE=Y/N – Include questionable addresses in sort. 

SORT_UNCODED_AS_RESIDUE=Y/N – Places invalid postal codes in residue containers. 

SPLIT_LARGE_BUNDLES=Y/N – Make 2 smaller bundles when a legal large bundle is 
constructed. 

MAILING_PLAN_FILE=Full path in which to save the mailing plan file. 

  

  

Gender Options 

GENDERIZE=Y" 

COLUMNTOGENDERIZE=The name of the field containing the names to genderize. 

COLUMNUPDATEDWITHVALUE=The name of the field that will hold the prefix. 

(will be generated if it doesn't exist.) 

AllENGLISH=Y/N - Use all english prefixes. 
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ALLFRENCH=Y/N – Use all french prefixes. 

BASEDONADDRESS=Y/N – Determine the prefix language based on the language of the 
address. 

ENGLISHMASCULIN=English prefix to use for male names. 

FRENCHMASCULIN=French prefix to use for male names. 

ENGLISHFEMININE=English prefix to use for female names. 

FRENCHFEMININE=French prefix to use for female names. 

ENGLISHANDROGYNOUS=English prefix to use for undetermined names. 

FRENCHANDROGYNOUS=French prefix to use for undetermined names. 

ENGLISHNOMATCH=English prefix to use for names not appearing in the list. 

FRENCHNOMATCH=French prefix to use for names not appearing in the list. 

  

  

Field Formatting Options 

UPPERLOWER=Y 

ALLUPPERCASE=Y/N - Format selected fields to upper case. 

ALLLOWERCASE=Y/N - Format selected fields to lower case. 

CAPITALIZEFIRSTLETTER=Y/N - Format selected fields with only the first letter in upper 
case. 

RULECAPITALIZATION=Y/N - Format selected fields to use double capitalization where 
appropriate 

UPPERLOWER_BUSINESS=Y/N - Use business rules(Y), use personal rules(N) 

(Requires RULECAPITALIZATION) 

**APPLYADDRESSCASING= 
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CASEACRONYMS=Y/N – Use the casing rules from the acronyms database. 

SHORTENACRONYMS=Y/N – Match with the long acronym and convert to short 
acronym. 

LENGTHENACRONYMS=Y/N – Match with the short acronym and convert to long 
acronym. 

SPACEPOSTALCODES=Y/N – If a selected field is the postal code field place a space in 
the middle. 

ADDRESSCASINGRULES=Y/N – Apply casing rules to selected address fields as well. 

UPPERLOWER_FRENCHCAPS=Y/N – Use the french capitalization rules. 

REMOVE_ACCENTS=Y/N – Remove accents from french words. 

 NUMBEROFFIELDSSELECTED=The number of fields selected 

UPPERLOWER_FIELD_NUMBER0=The name of the first field selected 

UPPERLOWER_FIELD_NUMBER1=The name of the second field selected 

UPPERLOWER_FIELD_NUMBER#=Same as above where # is the incrementing field 
selected. 

   

  

Graphic Analysis Report Options 

DEMOGRAPHIC=Y/N – Produce a demographic analysis report. 

DEMOGRAPHIC_FILE_NAME=The full path of the file to save the report to. 

DEMO_FIELD_NUMBER0=The full name of the report you wish to produce first. 

DEMO_FIELD_NUMBER1=The full name of the report you wish to produce second. 

DEMO_FIELD_NUMBER#=The full name of the report you wish to produce #-1. 
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Filter Mailing Options 

DOFILTERIZATION=Y/N – Run the filter mailing. 

FILTER_SEEDS=Y/N – Include the seed records when filtering. 

  

Intelligent Filter 

PROVINCEFIELDS=A comma separated, single quote surrounded list of province codes 
to filter. 

i.e. 'ON', 'BC', 'NS' 

CITIES FIELDS=A comma separated, unquoted list of cities to filter. 

i.e. Toronto, Vancouver, Halifax 

FSA FIELDS=A comma separated, unquoted list of FSA's or partial FSA's to filter. 

i.e. M1M, L4*, P* 

HASSTAR=Y/N – Does the city or FSA filter include asterisks? 

  

Address Type 

ADDTYPE_APARTMENT=Y/N – Filter address type apartment. 

ADDTYPE_GENERAL_DELIVERY=Y/N – Filter address type general delivery. 

ADDTYPE_GOVERNMENT=Y/N – Filter address type government. 

ADDTYPE_LVR=Y/N – Filter address type large volume receiver. 

ADDTYPE_RESIDENCE=Y/N – Filter address type residence. 

ADDTYPE_RURAL_ROUTE=Y/N – Filter address type rural route. 

ADDTYPE_PO_BOX=Y/N – Filter address type P.O. Box. 
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Expert Filter 

EXPERT_FIELD=The name of the field used for the expert filter. 

EXPERT_OPERATOR=The actual operator being used for the comparison. i.e. <> 

EXPERT_TEXT=The value to which the field is being compared via the operator. 

  

Random Filter 

RANDOM_TEXT=The number of records you wish to have remaining after the random 
filter. 

  

Extra Character Filter 

TAB=Y/N – Filter out tab characters. 

LINEFEED=Y/N – Filter out line feed characters. 

FORMFEED=Y/N – Filter out form feed characters. 

CARRIAGERETURN=Y/N – Filter out carriage return characters. 

WINDOWSNEWLINEFEED=Y/N – Filter out windows new line feed characters. 

  

Blank Lines Filter 

BLANKLINEADDRESS1=Y/N – Filter where address line 1 field is blank. (cumulative) 

BLANKLINEADDRESS2=Y/N – Filter where address line 2 field is blank. (cumulative) 

BLANKLINECITY=Y/N – Filter where city field is blank. (cumulative) 

BLANKLINEPROV=Y/N – Filter where the province/state field is blank. (cumulative) 

BLANKLINEPOSTALCODE=Y/N – Filter where the postal code/zip field is blank. 
(cumulative) 
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Customer Options 

CUSTOMERNAME=The name of the customer, usually company name. (Required) 

CUSTOMERNUMBER=The customers CPC account number. (Optional) 

CUSTOMER_CONTRACT_NUMBER=The customers contract number. (Optional) 

CUSTOMER_ADDRESS=The customers address. (Required) 

CUSTOMER_CITY=The customers city. (Required) 

CUSTOMER_PROV_STATE=The customers province or state. (Required) 

CUSTOMER_PC_ZIP=The customers postal code / zip code. (Required) 

CUSTOMER_COUNTRY=The customers country. (Required) 

CUSTOMER_USPS_MAILERID=The customers mailers ID, hyphen CRID. (Optional) 

i.e. 123456789-65495 

CUSTOMER_TOUSID=The customers CPC terms of use ID for NCOA. (Unused/Optional) 

  

Export Options 

 There are three exports that have the same parameters. To denote which type of 
export you are doing, you use the following parameters with no value, followed by the 
list below. 

 NORMAL_EXPORT= 

DUPLICATE_EXPORT= 

COMMON_RECORDS_EXPORT= 

  

The Export Parameters 

EXPORT_FILE_NAME=The full path of the file to export. 

EXPORT_FILE_TYPE=The type of file to export. 
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Access 97 

Access 2000 

DBase III 

DBase IV 

Excel 4.0 

Excel 5.0 

Excel 97 

Comma Delimited 

Tab Delimited 

Fixed Length 

Specify Delimiter 

CORRECTED_ADDRESS=Y/N – Include records with a 'C' in the Valid field. 

VALID_ADDRESS=Y/N – Include records with a 'V' in the Valid Field. 

EXPORT_UNCORRECTED=Y/N – Include the uncorrected records in the export. 

EXPORT_UNCODED_ADDRESS=Y/N – Include ONLY the uncoded records in the export. 

EXPORT_FOREIGN=Y/N – Include ONLY the foreign records in the export. 

EXPORT_EXTRACONTROLFIELDS=Y/N – Include the extra control fields as set or by 
default: 

[SORTEDID] [BAG] [LANG] [FCP] [Correct] [Correct_Text] 

[IsCommon] [BUN] [BUNTYPE] [Valid] [Dupes] [IsDupe] 

[AddType] [DF] [CITYC] [DCF] [RDF] [ADD_LOCALE] 

[MERGEFILE] [iAddressID] [PALLET] 
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CA_EXPORT_CORRECTION_FIELDS=Y/N – Include fields with correction responses: 

[VALID] [CORRECT] [CORRECT_TEXT] [IADDSTATUS] 

  

ADD_ORIGINAL=Y/N – Include the mapped original fields created by iAddress: 

[ORIGFIRM_NAME] [ORIGFNAM] [ORIGLNAM] [ORIGNAME1] [ORIGNAME2] 

[ORIGNAME3] [ORIGADD] [ORIGADD2] [ORIGCITY] [ORIGPROV] [ORIGPC] 

[ORIGUSER_LANG] [ORIGCOUNTRY] [ORIGURBANIZATION] 

  

EXPORT_ADD_ADDRESS_COMPONENTS=Y/N – Include the address component fields: 

[STREETNUMBER] [STREETNAME] [STREETTYPE] [STREETDIR] [SUITE] 

[POBOXNUMBER] [POBOXTYPE] [RRNUMBER] [ADD_EXTRA] 

  

EXPORT_ADD_STATUS=Y/N – Include status fields: 

[STATUS] [COMMENT] 

  

INCLUDE_ALL_FIELDS=Y/N – Include all unmapped fields from the original database. 

LEADING_ZEROS=Y/N – ListOrder is a number field, do you want it to be zero-padded. 

ONLY_SORTED_RECORDS=Y/N – Export only records that were included in the sort. 

UNSORTED_RECORDS_AT_END=Y/N – Include the unsorted records at the end of the 
export. 

REVERSE_SORT_ORDER=Y/N – Order the export by the descending value of ListOrder. 

ORIGINAL_ORDER=Y/N – Export your list in the order on import. 

EXPORT_COLUMN_HEADER=Y/N – Include the header row as the first row. (Text Files 
Only) 
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 EXPORT_TEMPLATE=The full path of the template to be used for fixed length export. 

(requires fixed length export) 

EXPORT_SPECIFY_DELIMITER=The delimiter to be used. i.e. “,” 

(require text file delimited export) 

EXPORT_SURROUND_WITH_QUOTES=Y/N – Surround text with quotes. 

(requires a text file export) 

 EXPORT_SPECIFIED_FIELDS=A comma delimited list of the exact fields in the exact 
order. Using this parameter can cause errors during export if the field names do not 
match. 

 EXPORT_EXTRACONTROLFIELDS_LIST=A comma delimited list of fields that qualify as 
extra control fields. Used only if EXPORT_EXTRACONTROLFIELDS is Y 

  

  

Duplicate Options 

DO_DUPES=Y/N – Run a duplicate extraction process. 

DUPES_ADD1=Y/N – Check dupes against ADD field. 

DUPES_ADD2=Y/N – Check dupes against the ADD2 field. 

DUPES_FNAME=Y/N – Check dupes against the FNAM field. 

DUPES_LNAME=Y/N – Check dupes against the LNAM field. 

DUPES_CITY=Y/N – Check the dupes against the CITY field. (Not recommended) 

DUPES_PROV=Y/N – Check the dupes against the PROV field. 

DUPES_PC=Y/N – Check the dupes against the PC field. 

DUPES_NAME1=Y/N – Check the dupes against NAME1 field. 

DUPES_NAME2=Y/N – Check the dupes against NAME2 field. 
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DUPES_NAME3=Y/N – Check the dupes against NAME3 field. 

DUPES_PERCENT_MATCH=The percentage match against name fields. 

DUPES_PARTIAL_NAME=Y/N – Match text within field instead of whole field. 

DUPES_IGNORE_RURAL=Y/N – Run the dupe on non-rural addresses only. 

DUPES_DELETE_DUPES=Y/N – Delete the duplicates on completion. 

DUPES_SAVE_DUPE_REPORT=The full path of the file to save the report. 

DUPES_SAVE_COMMON_REPORT=The full path of the file to save the report. 

DUPES_EXPORT_DUPLICATES=Y/N – Must have export values for duplicates export. 

DUPES_EXPORT_COMMON=Y/N – Must have export values for common export. 

DUPES_EXPORT_DUPES_ONLY=Y/N – Include only the duplicate records in the export. 

DUPES_EXPORT_DUPES_PLUS_ORIGINAL=Y/N – Include duplicates and originals in the 
export. 

DUPES_SUBTRACT=Y/N – Subtract common records. 

DUPES_KILL_FILE=The FILE number of the kill file. 

DUPES_DO_CORRECTION=Y/N – Run a quick correction before doing the dupes to 
normalize. 

DUPES_BLANK_AS_DUPE=Y/N – Match a blank and non-blank record. 

  

Dupe Priority Orders 

Please use the job wizard to create examples of how these parameters are used. The 
exact names need to be used and a spelling mistake here can cause an error during the 
setup for the duplicate removal process. 

DUPE_NO_FILES=Y/N – Either setting will activate priority sequencing 

DUPE_PRIORITY_ORDER=Semicolon delimited list of parameters denoting the order or 
priority. 
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DUPE_NUM_FILES=The number of files merged into your job. 

DUPE_FILE_PRIORITY=Semicolon delimited list of FILE numbers, indicating priority 
sequence. 

DUPE_NO_LENGTH_FIELDS=Y/N – Use the field length as a priority. 

DUPE_LENGTH_FIELDS=Semicolon delimited list of field names to use for priority 
sequence. 

DUPE_CORRECT_VALID=C,V or U depending on what value you want to prioritize. 

DUPE_FRENCH_ENGLISH=E, F or NONE for priority sequence on language. 

DUPE_SEQUENTIAL_FIELD=The name of the field to use. 

DUPE_SEQUENTIAL_ASCDESC=A for Ascending and D for Descending. 

DUPE_SEQUENTIAL_COMPARE_TYPE=0 for a binary compare, 1 for a text compare. 

  

Labels Options 

CONTAINER_BAG_PRINTER=The name of the printer as it appears in the printers list. 

(If printing) 

CONTAINER_BAG_TRAY=The printer tray that will be used. (If printing) 

CONTAINER_BAG_PDF=The full path to which to save the pdf file. 

BUNDLE_PRINTER=The name of the printer as it appears in the printers list. (If 
printing) 

BUNDLE_TRAY=The printer tray that will be used. (If printing) 

BUNDLE_PDF=The full path to which to save the pdf file. 

MONOTAINER_PALLET_PRINTER=The name of the printer as it appears in the printers 
list. (If printing) 

MONOTAINER_PALLET_TRAY=The printer tray that will be used. (If printing) 

MONOTAINER_PALLET_PDF=The full path to which to save the pdf file. 
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PRINT_JOB_NAME=Y/N – Print the job name on the container labels. 

 PRINT_BUNDLE_LABELS_STACKABLE=Y/N – Print the labels stackable. 

PRINT_CONTAINER_LABELS_STACKABLE=Y/N – Print the labels stackable. 

CONTAINER_BAG_LEGAL=Y/N – Print the container labels on legal paper. 

MONOTAINER_PALLET_PAPER_SIZE=1 for letter size, 5 for legal size pallet label. 

SAVE_LABELS_TO=The Folder in which the labels will be saved. 

SAVE_LABELS_PREFIX=An indicator to put at the beginning of the label file names. 

  

   

Report Options 

Print reports 

 PRINT_ALL_REPORTS_TO=The name of the printer as it appears in the printers list. (If 
printing) 

PRINT_REPORTS_TO_TRAY=The printer tray that will be used. (If printing) 

 NUM_VALIDATION_REPORT_COPIES=Number of copies of the validation report. 

NUM_UNCORRECTABLE_REPORT_COPIES=Number of copies of the uncorrectable 
report. 

NUM_CORRECTED_REPORT_COPIES=Number of copies of the corrected report. 

NUM_STATEMENT_OF_MAILING_COPIES=Number of copies of the statement of 
mailing. 

NUM_STATEMENT_OF_MAILING_PDF_COPIES=Number of copies of the PDF. (requires 
save) 

NUM_DELIVERY_COPIES=Number of copies of the volume summary. 

NUM_REPORT_CONTAINER_COPIES=Number of copies of the bag and bundle report. 
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Save Reports 

SAVE_VALIDATION_REPORT_TO_FILE=Full path to save the validation report. 

SAVE_REPORT_UNCORRECTABLE_TO_FILE=Full path to save the uncorrectable report. 

SAVE_REPORT_CORRECTED_TO_FILE=Full path to save the corrected report. 

SAVE_STATEMENT_OF_MAILING_TO_FILE=Full path to save the statement of mailing. 

SAVE_STATEMENT_OF_MAILING_TO_PDF_FILE=Full path to save the statement of 
mailing pdf. 

SAVE_DELIVERY_TO_FILE=Full path to save the volume summary. 

SAVE_REPORT_CONTAINER_TO_FILE=Full path to save the bag and bundle report. 

  

Saving iAddress Jobs Files 

SAVE_FILE_CORRECTED=Full path to save the iAddress job file after correction. 

SAVE_FILE_SORTED=Full path to save the iAddress job file after sort. 

SAVE_FILE_COMPLETE=Full path to save the iAddress job file after all processes 
complete. 

Appendix 

Move Update Codes 

NCOA (Column NCOA) 

NCOA (column "NCOA"): 

• UM (Unmatchable Record): General Delivery, Invalid or no name 

• NM (Non-Matched Record): Valid address that does not appear in the NCOA database 
(a.k.a. person hasn't moved) 

• UB (Unapplied Business Match): A record that matched as a business move but has not 
yet been applied to the job. 

• UI (Unapplied Individual Match): A record that matched as an individual move but has 
not yet been applied to the job. 

• UF (Unapplied Family Match): A record that matched as a family move but has not yet 
been applied to the job. 
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• UN (Unapplied Nixie Match): A record that matched as a nixie record but has not yet 
been applied to the job. 

• AB (Applied Business Match): A record that matched as a business move and has been 
applied to the job. 

• AI (Applied Individual Match): A record that matched as an individual move and has 
been applied to the job. 

• AF (Applied Family Match): A record that matched as a family move and has been 
applied to the job. 

• AN (Applied Nixie Match): A record that matched as a nixie record and has been 
removed from the job. 

3rd Characters (Canada): 

• C: CPC initiated - Canada Post put in the NCOA record 

• U: Rural to Urban Conversion 

• M: NCOA Moveback - Person moved and then moved back to the previous address. 
• X: Privacy - No documentation, generally associated with nixies. 

3rd/4th Characters (U.S.): 

• "A": Perfect Match 

• "01": Perfect match but a foreign record is returned 

• "02": Match! Nixie 

• "03": Match! Nixie P.O. Box 

• "14": Match! (New address is undeliverable) 

• "19": Match! Non automation record returned. (no zip 4 coding) 

• "91": Match! Some secondary information was absent in the input address, therefore it 
is dropped from return. 

• "92": Match! Some secondary information was absent in the master record, therefore it 
is dropped from return. 

• "04": No Match (address good but needs individual information, only has family) 

• "09": No Match (address good but needs individual information, Family match to 
Building not permitted) 

• "10": No Match (address good but needs individual information, Family match to Rural 
Route not permitted) 

• "18": No Match (address good but needs individual information, Family match to GD not 
permitted) 

• "11": No Match BUT This would be a match if family matching is used. 
• "15": No Match BUT This would be a match if family matching is used. 
• "00": No Match -- perfect no match 

• "": No Match -- record is uncoded 

• "06": No Match (address good but individual information does not match) 

• "16": No Match (address good but individual information does not match) 

• "17": No Match (address good but individual information does not match) 

• "13": No Match (address good but individual information does not match) 

• "12": No Match (address is good but middle initial conflicts on individual matching) 

• "66": No Match (used to be a match) 

• "05": No Match (address good but delivery point is ambiguous) 
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• "07": No Match (address good but genders do not match) 

• "08": No Match (address matched to multiple results that were conflicting.) 

• "20": No Match, too many possible returns 

DNM (column "DNM_CODES"): 

• UM (Unmatchable Record): General Delivery, Invalid or no name 

• NM (Non-Matched Record): Valid address that does not appear in the DNM database 
(a.k.a. person hasn't moved) 

• UC (Unapplied Change): Matched to DNM but not purged 

Move Update Extras (column "MVUP_CODES"): 
Character Position 1 & 2 Deceased List. 

• UD (Unapplied Deceased): Matched to deceased list but not purged 

• NM (Non-Matched): Failed to match to the deceased list 

Canadian Correction Codes 

The correct field returns a [NUMERIC][ALPHA] ([NUMERIC][ALPHA] ...) list of the 
correction codes. The numeric specifies which components of the address has been 
changed. The alpha specifies reason for the change. 

Alpha Values 

• A = Alternate 

• F = Would not fit 
• I = Incorrect Value 

• M = Missing Value 

• R = Rural validated on postal code only 

• T = Typo in Value 

• V = Verbosity 

Numeric Values 

• 01 Addressee and/or Additional Delivery Information 

• 10 Complete Street Information 

• 11 Civic number 
• 12 Civic number suffix 

• 13 Street name 

• 14 Street type 

• 15 Street direction 

• 16 Suite keyword 

• 17 Suite identifier 
• 19 Delivery Information 
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• 20 Complete Route Service Information 

• 22 Route Service Keyword 

• 24 Route Service identifier 

• 30 Complete PO Box/Bag Information 

• 32 PO Box/Bag keyword 

• 34 PO Box/Bag identifier 

• 40 Complete General Delivery Information 

• 42 General Delivery keyword 

• 50 Complete Delivery Installation Information 

• 52 Delivery Installation Area Name 

• 54 Delivery Installation Type 

• 56 Delivery Installation Qualifier 

• 60 Municipality 

• 62 Province 

• 64 Postal Code 

Canadian Validation Codes 

V - Valid: The address did not need to be changed. 

C - Corrected: The address changed from input. 

U - Uncorrectable: iAddress was unable to provide a correction for this address. 

G - Foreign: The address is foreign to Canada. 

F - Failed: The address caused an error during correction, contact Flagship Software 
Support. 

US Correction Codes 

Brief Description of Us Correction Codes 

Code Definition 

AA / A2 / A3 / A5 / A6 / A9 /AU / BB / 
CC 

/ DD / D1 / D2 / EE / E1 / E2 /E3 / E4 / 
E5 

/ FF / F1 / G1 / II / I1/ HH / H1/ RR / 
S1 

Address Corrected / Valid 
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/ S1 / S2 / S3 / UA / UB / UC / UD / U1 
/ X1 

/ Z0  

KK / Z1 / Z2 Address Uncorrectable 

A1 No Zip + 4 match 

A7 Rejected due to EWS 

A8 Address not specified 

AC Multiple County’s defined 

G4 
Street Number out of Range of alias street 
match. 

JJ Failed to Match last line of address 

K1 Missing / Incorrect street Directional(s) 

K2 Missing / Incorrect street suffix 

MA / MC / M1 / M3 Missing Street Number 

MB Street Name Not Found 

MD Firm Name not matched 

NA / NB / NC / N1 / R1 Missing / Incorrect Secondary Number 

P1 / P2 / P3 / Q1 / Q2 Missing / Incorrect RR/HC/PO Box Number 

  

 

 

 

Extended Description of Error Codes 

Code Definition 

AA 
Record Matched to the ZIP+4 File 
This footnote is set any time that a record is matched. This is the equivalent of 
having a return code of 31 or 32. 

A1 

Record Not Matched to the ZIP+4 File 
This footnote is set every time that a record does not match to the ZIP4 file, 
but makes it through basic parse and last line validation. This is the equivalent 
of having a return of 21 or 22. 
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A2 
Alias Street Name Matched 
This footnote is set every time a match is made to an alias street name. 

A3 

Alternate Record Matched on the ZIP+4 File 
This footnote is set every time a match is made to an alternate ZIP4 record. 
An alternate record contains a different presentation a street name for a 'base' 
ZIP4 record. The addon code is the same for the alternate and the base record. 

A4 

  

Match to Small Town Default 
A small-town default match does not actually match to an existing ZIP4 
record, but gives back a return code of '31' and an addon code of '9999'. This 
condition exists when the input ZIP code is flagged as a 'Small Town' and 
only accepts 'GENERAL DELIVERY' type addresses, but a street-style or PO 
BOX address was presented on input. Since there are no actual street or PO 
BOX deliveries, all addresses in this ZIP code will get a 'default' addon of 
'9999'. 

A5 

Match to Unique ZIP Default 
A Unique ZIP code is a ZIP code set up by an institution (like a university) or 
a business that handles its own mail delivery. The USPS collects the mail at 
the post office, and the institution picks it up and distributes it internally. 
Even though it is possible to have ZIP4 records for Unique ZIP code, most 
institutions have addressing schemes that are not fully populated in the 
database. Therefore, when an input Unique ZIP code is found, and the input 
address is not found, a return code of '31' is given back, along with a 'default' 
addon of '0001'. 

A6 

Match to a Highrise Default Alternate record 
This footnote is set when a Highrise Default Alternate style address match is 
made. This condition exists when an input address contains the secondary 
number (an apartment, suite, etc.) along with a building name. No primary 
number or street name is given. For example: 
456 FEDERAL BUILDING 
The coder will take this address and turn it back into a street-style 
presentation. 
123 MAIN ST STE 456 

A7 
Address rejected due to EWS 
See the chapter titled 'EWS System' for information on how EWS works. 

A8 

Possible dual address detected 
This footnote is set when a 'dual address' may be present, such as: 
RR 3 BOX 123 456 MAIN ST 
Since there are 2 possible addresses available, the Coder will not choose 
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which one to parse and return. This address construct results in a 21 return 
code. 

A9 

DPV used to break ZIP4 multiple response 
In some cases when a multiple-response is found during ZIP4 address 
processing, the DPV engine can be used to break the tie. During this process, 
all the candidate records are queried against the DPV database. If one and 
only one record is found to have a positive DPV confirmation, then this 
record will be chosen for the match, and a single response code is given back 
from the address lookup process. This footnote is turned on under this 
condition. 

AC 

ZIP+4 Level county name is different than the ZIP Code level 
Note: This footnote will only be returned if the ZIP4_COUNTY parameter is 
specified in either the configuration file or the AC_OPEN_T structure. See 
the 'Configuration File' chapter for details on when this footnote is set. 

AU Unique ZIP default information returned. 

BB 
DPV match, all components. A DPV match was made using all the components 
of the address (primary and secondary number). 

CC 

DPV match primary number, not secondary number 
A DPV match was made with the primary number only. A secondary number 
was present on the input address, but was not used for DPV. 

DD 
Corrected City Name and/or State Information 
The city or the state was changed. 

D1 

Input city name was non-mailing, corrected (AC) 
The input city name was a non-mailing name for the matched ZIP code. The 
output address contains the corrected city name. 

D2 

ZIP+4 State code different than ZIP Code default 
This footnote indicates that the state code on a matched ZIP4 record differs 
from the state code assigned to the ZIP code of the output address. This can 
happen when a physical address exists in one state, but the mail is delivered 
to that address from another state. In some geographical situations, it is better 
for a post office in one state to deliver mail to addresses that are in a 
neighboring state. In these situations, the output address of the Coder will still 
show the state code of the delivering post office. The state code of the 
physical address will be shown in the matching ZIP4 record (the matched_rec 
field of the AC_OUTPUT_ADDR_T structure. 

EE 
Corrected Primary Address (E1 or E2 is on) 
The primary address line was corrected. 

E1 
Corrected primary address component (AC) 
A directional or suffix address component was added, deleted, or changed. 
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E2 
Corrected primary street name (AC) 
Set if the street name spelling was changed. 

E3 
Primary address line standardized (AC) 
Set if any portion of the primary address line was standardized. 

E4 

A questionable address standardization was made. This can happen when an 
input address looks like 123 MAIN ST BOX 123 (a possible dual address), 
and it gets standardized to 123 MAIN ST # 123. 

E5 The first letter of the street name has been added or changed. 

FF 

Corrected Secondary Address Data 
Set when the secondary number or unit designator was changed. Examples of 
allowable secondary number changes are reversing alpha-numerics, and 
adding or deleting dashes: 
A5 => 5A 
A5 => A-5 

F1 

Military match 
A match was made to a ZIP Code that has been determined to be a Military 
ZIP Code. 

G1 
General Delivery match 
A match was made to a General Delivery ZIP+4 record. 

G4 

Out of range alias match 
A match was made to an alias street name, but the primary number did not 
match the allowable range for the alias street name. This is a 'no-match' 
condition and a return code of '21' is given back. 

II 
Firm and address swapped (AC) 
The firm line and the address line were swapped to make the match. 

I1 

Urb moved from address line (AC) 
A PR Urbanization was found in the address line and moved to the 
Urbanization line. 

HH 
ZIP Code Changed 
The input ZIP code was changed. 

H1 
ZIP code added (AC) 
No ZIP code was in the input address, and one was added. 

JJ 

Failure to Match Last Line of Address 
The last line was not able to be matched. This is equivalent to the return code 
'11'. 

KK Multiple Match in Primary Address Field 

K1 Multiple Match due to Missing/Incorrect Directional(s) 

K2 Multiple Match due to Missing/Incorrect Suffix 
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MA 
ZIP4 -Missing Street Number 
A primary number is missing from the input address. 

MB 
ZIP4 - Street Name Not Found 
The input street name could not be found in the ZIP+4 data file. 

MC 

ZIP4 - No Such Primary Number 
This is set when the input street name was found in the ZIP+4 file, but the 
input primary number could not be found with the given street name. 

MD ZIP4 - Firm Name Not Matched 

M1 
DPV -Missing Street Number 
A primary number is missing from the input address. 

M3 

DPV - No Such Primary Number 
This is set when DPV cannot validate the primary number, even though the 
address matched to a valid ZIP+4 range. 

NA 

ZIP4 -Missing Secondary Address Number 
A match was made to a ZIP+4 Highrise record, but no secondary number was 
present on the input address. 

NB 

ZIP4 - Secondary Number not found 
A match was made to a ZIP+4 record, but the input secondary number could 
not be found. 

NC 

Multiple Match in Secondary Address Field 
Set when a 'multiple response' condition occurs with highrise specific records, 
and one cannot be picked. The Coder returns the highrise default or street 
level record. For example: 
Input address is '123 MAIN ST # 4' and both APT 4 and STE 4 are present. 
NOTE: This footnote used to be called L. 

N1 

Missing Secondary Address Number for an Address located within a highrise 
For DPV, a match was made to a Highrise record, but the secondary number 
was not present on the input address. 

P1 

Missing RR/HC Box Number for rural-route style addresses, 

the BOX number was missing on input. 

P2 
RR/HC Box Number not found 
Currently not being set. 

P3 Invalid RR/ HC/ PO BOX number. 

Q1 Missing PO Box Number 

Q2 PO Box Number not found 

RR 
DPV - CMRA match 
The CMRA flag was set in DPV. 
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R1 DPV - CMRA, no secondary number 

S1 

Seasonal record information present 
This footnote indicates that seasonal information is present. The seasonal 
information is in the 'seasonal' field of the AC_MATCH_INFO_T structure. 
Certain addresses receive mail only during part of the year. The 'seasonal' 
field contains a 12-character, NULL-terminated string indicating which 
months have mail delivery for the given output address. The field is a string 
of 'Y' and 'N' flags. Each of the 12 positions correspond to the 12 months of 
the year. A 'Y' value in a position indicates that the mail is delivered for that 
month. For example, the string 'NNNNYYYYNNNN' shows that mail is only 
delivered in the months ofMay, June, July, and August. 

S2 SUITE Link information added to the address. 

S3 Address matched to STOP Link. 

UA 

No PR Urbanization was given with the input address, but an Urbanization 
was found in the matched ZIP4 record. This Urbanization was returned on 
output. 

UB 
The input PR Urbanization was verified to be valid according to the ZIP4 
record that was matched. 

UC 

The input PR Urbanization was not verified with the matched ZIP4 record, 
because the matched record contained a blank Urbanization field. The input 
Urbanization was retained in the output address. 

UD 

The input PR Urbanization was not verified with the matched ZIP4 record, 
because the matched record contained a different Urbanization name. The 
Urbanization from the matched ZIP4 record was returned with the output 
address. 

U1 

Unique ZIP Code Match 
A match was made to a ZIP Code that has been determined to be a Unique 
ZIP Code. See footnote A5 for more information on Unique ZIP Codes. 

X1 

IntelliZIP match 
This footnote indicates that a match was made using IntelliZIP logic. If a 
match is not made through normal address matching procedures, and if the 
input address contains a 9-digit ZIP code, then a reverse 9-digit lookup is 
performed. If the ZIP+4 record corresponding to the input 9-digit ZIP code 
closely matches the input address, then a match will be returned and this 
footnote will be set. 

Z0 

ZIPMOVE match 
A match was made to a ZIP Move address. ZIP Move represents a collection 
of addresses that have been affected by a ZIP code realignment (i.e. the 
boundaries for a ZIP code were redrawn).When this happens, some street 
segments will move from one ZIP code to another. This can cause problems 
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when an input address contains the 'old' ZIP code, and the address matching 
software tries to change the address to keep it in the old ZIP code instead of 
moving to a new ZIP code. To help out, the USPS keeps a separate file of 
these situations that are used by address matching software. This footnote is 
set when the input address contains the old ZIP code, and the Coder changed 
it to the new ZIP code. An exact match must be made to the address in order 
for this to happen. 

Z1 

ZIPMOVE no match due to component change 
The best match available was to a ZIP Move address, but the input address 
was changed to get there. This is not allowed, so a no-match condition is 
made with a return code of '21'. 

Z2 

ZIPMOVE no match due to invalid new ZIP+4 
This represents a data inconsistency with the USPS ZIP4 and ZIP Move files. 
The address was no-matched with a return code of '21' 

iAddStatus Field  

Character 

Position 
Element  Values 

1 
Record Type 

Code 

Defines the type of record in the Address Lookup and the Text Lookup file. The 

values are: 

1 = Street Address Record 

2 = Street Served by Route Record 

3 = Lock Box Address Record 

4 = Route Service Address Record 

5 = General Delivery Address Record 

A = Building Name Record 

B = Large Volume Reciver Name (Street) Record 

C = Government Name (Street) Record 

D = Large Volume Receiver Name (Lock Box) Record 

E = Government Name(LockBox) Record 
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F = General Delivery Name Record 

2 
Address 

Type Code 

A code denoting wheather an address is in the for of a civic address or in the form 

of a delivery installation address. Valid values are: 

1 = Civic (Street) Address Format 

2 = Delivery Installation (Station) Address Format 
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3 

Delivery 

Mode Type 

Description 

 The part of the Delivery Mode which identifies the type of delivery service 

A = Delivery to Block Face Address 

B = Delivery to an Apartment Building 

E = Delivery to a Business Building 

G = Delivery to a Large Volume Receiver 

H = Delivery via a Rural Route 

J = General Delivery 

K = Delivery to a PO Box (not a CMB) 

M = Delivery to a Large Volume Reciver (PO BOX) 

T = Delivery via a Suburban Service 

X = Delivery via a Mobile Route 

Z = Postal Code is retired (No further delivery to this code) 

 4 - 5 
Questionable 

Flags 

QB = Questionable PO Box 

QR = Questionable Rural 

 

 

 

 

 

 

 

 

 


